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In questa Guida…
Questa guida all'uso contiene istruzioni su come avviare, 
utilizzare, risolvere i problemi e sottoporre a manutenzione lo 
scanner per microarray Agilent. 

1 Introduzione 

Questo capitolo descrive lo scanner per microarray e la 
preparazione necessaria per il suo funzionamento.

2 Operazioni preliminari

In questo capitolo viene spiegato come utilizzare in sicurezza lo 
scanner per microarray e come preparare ed effettuare la 
scansione dei vetrini con il programma Agilent Scan Control.

3 Modifica delle impostazioni di scansione

Informazioni sul funzionamento delle impostazioni di scansione 
e su come e quando modificarle.

4 Utilizzo degli strumenti

In questo capitolo viene spiegato come impostare i profili — 
gruppi di impostazioni di scansione — regioni di scansione e 
tempi di accensione/spegnimento automatici del laser.

5 Manutenzione e risoluzione dei problemi del sistema

In questo capitolo vengono descritte procedure e consigli per la 
manutenzione, e messaggi di errore per la risoluzione dei 
problemi del sistema. 

6 Consultazione

Questo capitolo presenta le specifiche per i vetrini e fornisce 
informazioni di ottemperanza alle normative.
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Questo capitolo contiene un'introduzione generale allo 
Agilent G2565CA Scanner per microarray 

Uno strumento 
potente...

Questa sezione descrive le caratteristiche che rendono lo 
scanner per microarray uno strumento potente nella soluzione 
di studio dei microarray di Agilent. 

Descrizione del 
sistema

In questa sezione vengono illustrate le caratteristiche hardware 
e software dello scanner per microarray, le parti e i requisiti di 
sistema, informazioni sulla preparazione del sito e le linee guida 
per la sicurezza. 

Principi di 
funzionamento

Questa sezione spiega il funzionamento dello scanner per 
microarray. 
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1 Introduzione 
 

Uno strumento importante per lo studio dei microarray

Lo Scanner per microarray Agilent G2565CA fa parte della 
soluzione di studio dei microarray di Agilent Technologies. Lo 
scanner per microarray è un sofisticato scanner di fluorescenza 
indotta da laser concepito per leggere i microarray stampati su 
vetrini standard da 1” × 3”. 

Lo scanner per microarray misura l’intensità della fluorescenza 
del campione di acido nucleico marcato (DNA e RNA) legato ai 
microarray. La sua capacità di misurare simultaneamente la 
fluorescenza da due colorazioni facilita tutti gli studi di 
microarray a due colori. Questa tecnologia garantisce una 
scansione dei microarray rapida, di elevata qualità ed 
automatica.

Figura 1 Scanner per microarray Agilent G2565CA 

Ogni vetrino viene scansito nel giro di pochi minuti e i file 
vengono preparati per l'analisi. 
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Descrizione del sistema

In questa sezione vengono elencate le funzioni hardware e 
software, componenti e requisiti del computer, una descrizione 
fisica dello scanner e informazioni sulla preparazione del sito e 
sulla sicurezza.

Funzioni hardware e software
Lo scanner per microarray offre le seguenti funzioni: 

• Lettura interna ed esterna del codice a barre

• Auto-focus dinamico

• Calibrazione automatica con guadagno di PMT prima di ogni 
scansione

• Stabilizzazione continua della potenza laser

• Dimensioni dei pixel pari a 2, 3, 5 o 10 micron

• Intervallo dinamico di >104 per una scansione singola in 
modalità di scansione a 16 bit, >105 per una scansione 
singola in modalità di scansione a 20 bit, e >106 per una 
scansione doppia in modalità di scansione a 16 bit (XDR)

• Compressione dei file di immagine TIFF

• Specifica di uniformità di <5% CV (Coefficiente di variazione)

Il software Scan Control consente di selezionare i canali di 
colorazione (fluorescenza), le regioni di scansione, la 
risoluzione, l'intervallo dinamico, il guadagno di PMT e le 
cartelle di output per ciascuno dei vetrini nel ciclo del 
caricatore. Queste impostazioni possono essere caricate 
automaticamente da profili specifici per applicazione o possono 
essere selezionate individualmente.

Elenco dei componenti
Lo scanner per microarray Agilent G2565CA comprende i 
seguenti componenti:

• Scanner per microarray

• Caricatore circolare e 50 portavetrini
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1 Introduzione 
Requisiti del computer 

• Stazione di lavoro con software di ripristino su CD

• Cavi di alimentazione e USB

• Software Scan Control 8.3

• Software Feature Extraction 10.x 

• Dichiarazione di Conformità

Il software Agilent Scan Control 8.3 è progettato per l'uso con il 
software Agilent Feature Extraction 9.5 e successive versioni. 
Le scansioni a 5 e 10 micron, a 16 bit, offrono compatibilità 
retroattiva con FE 9.5. Le scansioni a 2 e 3 micron, e tutte le 
scansioni a 20 bit, richiedono FE 10.x.

Requisiti del computer
Prima di installare e utilizzare il software Agilent Scan Control, 
verificare che siano presenti i seguenti elementi:

Software

• Windows XP Professional con SP2 

• Internet Explorer 5.5 o una versione successiva

Hardware

• Pentium IV a 3,2 GHz o superiore

• Richiesti 2 GB di RAM (4 GB di RAM se il software Feature 
Extraction è installato sullo stesso PC)

• 250 GB di spazio disponibile su disco per i programmi e la 
generazione dei dati
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Descrizione fisica dello scanner

Vista frontale dello scanner

Figura 2 Scanner per microarray, vista frontale

Vista dall’alto dello scanner

Figura 3 Scanner per microarray, vista dall’alto

Coperchio

Indicatori 
luminosi 
di stato

Interruttore di 
accensione

Bocca del filtro dell’aria 
e porta di accesso

Coperchio

Etichetta 
informativa

Base di 
supporto del 
caricatore 
circolare

Braccio di caricamento 
automatico del portavetrini
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1 Introduzione 
Preparazione del sito 

Vista posteriore dello scanner

Figura 4 Scanner per microarray, vista posteriore

Preparazione del sito
Verificare che l’ambiente soddisfi 
le “Specifiche dello scanner per 
microarray” a pagina 96 contenute 
nel Capitolo 6. In caso di domande, 
contattare il centro vendita e 
assistenza Agilent locale oppure 
visitare il sito 
www.agilent.com/chem/ 
dnasupport.

Connessione USB
Portafusibili del laser

Portafusibili di 
alimentazione

Tensione di rete 
finestrella indicatrice

Impostazione della 
tensione di rete

Bocca dell'aria

Presa di alimentazione

Assicurarsi 
che il coperchio 
di accesso 
abbia spazio a 
sufficienza

Posizionare l’unità 
su un tavolo di 
laboratorio o su un 
piano robusto
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Simboli di sicurezza sullo scanner
Simbolo di ATTENZIONE

Il simbolo di ATTENZIONE è posto sul prodotto quando è 
necessario fare riferimento alla guida del prodotto per 
comprendere un potenziale pericolo. L'avviso richiama 
l'attenzione su una procedura operativa, una prassi o comunque 
un'azione che, se non eseguita correttamente o attenendosi 
scrupolosamente alle indicazioni, potrebbe comportare danni al 
prodotto o la perdita di dati importanti.

Simbolo di AVVERTENZA

Il simbolo di AVVERTENZA è posto sul prodotto all’interno 
dell’area in cui è presente una tensione pericolosa oppure 
quando esiste il rischio di scosse elettriche. In quest’area deve 
operare solo personale di assistenza addestrato. 
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1 Introduzione 
Simboli di sicurezza sullo scanner 

Linee guida di sicurezza

Lo scanner per microarray Agilent G2565CA è stato concepito 
per un impiego semplice e sicuro. Assicurarsi di comprendere e 
osservare tutte le avvertenze e gli avvisi prima di azionare lo 
scanner per microarray.

AV V E R T E N Z A Non tentare di riparare o accedere ai componenti interni dello scanner 
per microarray. Esiste il rischio di esporsi ad alta tensione e a radiazioni 
laser pericolose. La rimozione delle coperture invalida la garanzia.

AV V E R T E N Z A Lo scanner per microarray deve essere collegato a una sorgente di 
alimentazione dotata di messa a terra. Per la sicurezza è necessaria 
una messa a terra di protezione.

AT T E N Z I O N E Quando si accende lo scanner per microarray per la prima volta oppure 
si trasferisce l’unità in un nuovo sito, verificare che l'impostazione 
della tensione sia corretta e che vi sia il collegamento "a terra". 

AT T E N Z I O N E Agilent raccomanda di posizionare lo scanner per microarray su un 
tavolo di laboratorio o un piano robusto. Lo scanner per microarray è 
una potenziale fonte di vibrazione ed è potenzialmente sensibile alla 
vibrazione esterna.

AT T E N Z I O N E Lo scanner per microarray è potenzialmente sensibile alle condizioni di 
umidità con generazione di condensa. Seguire le precauzioni indicate 
nella documentazione del prodotto. Vedere “Consigli per evitare 
problemi” a pagina 71 del capitolo 5 e le relative specifiche di umidità a 
pagina 96 del capitolo 6.
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Principi di funzionamento

Questa sezione descrive le caratteristiche di funzionamento 
dello scanner per microarray Agilent G2565CA.

Posizionamento dei vetrini
Lo scanner per microarray ospita fino a 48 vetrini da 1" × 3" in 
un caricatore circolare rimovibile. Durante un ciclo del 
caricatore, i vetrini vengono trasportati in sequenza nella 
posizione di scansione, ne viene effettuata la scansione e quindi 
vengono riposti nel caricatore.

Eccitazione laser
Lo scanner per microarray utilizza due laser, un laser SHG-YAG (532 
nm) e un laser elio-neon (633 nm). I laser eccitano l'RNA o il DNA 
marcato con cianina-3 (Cy-3) e cianina 5 (Cy-5) per misurare la 
fluorescenza dopo l'ibridazione dell'acido nucleico di destinazione 
alle sonde per microarray. È possibile utilizzare altri coloranti simili 
a Cy-3 e Cy-5, come i coloranti Alexa 647, 555 e 660.

Gli scanner per microarray sono ottimizzati per un’alto 
rendimento segnale-disturbo nelle bande di emissione Cy-3 
(550—610 nm) e Cy-5 (650—750 nm), con un ampio intervallo 
dinamico (fino a cinque ordini di grandezza) e cross-talk 
spettrale basso. Questo consente di misurare un intervallo 
molto ampio di concentrazioni di destinazione e garantisce una 
maggiore sicurezza dei dati a livelli di segnale bassi. 

Scansione
L’eccitazione laser viene scansita rapidamente avanti e indietro 
attraverso il microarray. Il gruppo dinamico/di tracciamento 
con auto-focus garantisce che il microarray sia sempre 
posizionato sul piano di messa a fuoco delle lenti di scansione, 
per una maggiore uniformità di scansione.



18 Guida all'uso dello Scanner per microarray Agilent G2565CA (software Scan Control 8.3)

1 Introduzione 
Rilevamento della fluorescenza 

Rilevamento della fluorescenza
La fluorescenza dei campioni etichettati viene convertita in un 
segnale elettrico da un PMT ad elevate prestazioni. 
Amplificatori con un disturbo bassissimo e integratori digitali 
elaborano il segnale PMT in un valore digitale che viene 
registrato nel file TIFF.

Sottrazione dark offset
A livelli di segnale molto bassi, il disturbo può causare valori di 
pixel negativi. Invece di impostare tali valori su zero, portando 
ad una misurazione errata, lo scanner Agilent aggiunge un 
piccolo offset a tutti i valori di pixel, consentendo di riferire la 
distribuzione completa dei pixel. Questo offset costante non è 
disturbo, e viene rimosso in modo statisticamente corretto dal 
software Agilent Feature Extraction.
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Questo capitolo descrive il funzionamento dello scanner e 
fornisce le istruzioni necessarie per impostare ed eseguire la 
scansione dei vetrini in modo rapido e semplice. 

In caso di problemi, vedere le informazioni sulla risoluzione dei 
problemi al Capitolo 5.
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2 Operazioni preliminari 
Richiesta della licenza per scansione ad elevata risoluzione 

Licenza

Lo scanner Agilent può essere ordinato in due configurazioni:

• la configurazione ad elevata risoluzione standard, o 

• con la funzionalità ad elevata risoluzione eliminata

Senza la licenza per elevata risoluzione, è possibile effettuare la 
selezione a 10 micron, 5 micron e doppia passata a 5 micron, ma 
le selezioni a 2 e 3 micron non sono disponibili.

Se è stata acquistata la funzionalità ad elevata risoluzione, è 
necessaria la licenza software per attivare questa funzionalità. 
Nella maggioranza dei casi, il tecnico che installerà lo scanner 
installerà anche la licenza. In caso contrario, o in caso la 
funzionalità venga acquistata in seguito, seguire le istruzioni 
riportate sotto per ricevere la licenza software.

Richiesta della licenza per scansione ad elevata risoluzione
Per richiedere la licenza per scansione ad elevata risoluzione: 

1 Reperire il SEC (software entitlement certificate) fornito con 
lo scanner.

2 Vistare il sito https://software.business.agilent.com/index.stm.

3 Selezionare Click here to start software license redemption. 

4 Seguire le istruzioni per ottenere la licenza.

Installazione della licenza per scansione ad elevata risoluzione
Una volta ricevuta la licenza per e-mail, installarla come segue:

1 Chiudere la finestra del software Scan Control.

2 Ubicare il file di licenza e posizionarlo nella seguente directory:

C:\ProgramFiles\Agilent\Microarray

3 Riavviare il software Scan Control.

Ora sono disponibili le selezioni a 2 e 3 micron.

https://software.business.agilent.com/index.stm
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Licenza per codici a barre non Agilent

Se si ha la necessità di effettuare la scansione di codici a barre 
non Agilent con risoluzione a 2 o 3 micron, contattare Agilent per 
una licenza speciale gratuita per l'accesso a questa funzionalità. 

Senza questa licenza, se il codice a barre di un vetrino non è 
presente o non viene riconosciuto dallo scanner come array 
Agilent, e l'array deve essere scansito con risoluzione a 2 o 3 
micron, lo scanner salterà il vetrino e verrà visualizzato il 
seguente messaggio:

“Scan settings or slide is not supported by the current scanner 
license. Contact Agilent via pdl-non_ag_barcode@agilent.com to 
obtain license to scan non-Agilent barcodes in high-resolution”.

Richiesta ed installazione di una licenza per codici a barre non Agilent

1 Inviare una e-mail all'indirizzo 
PDL-non_ag_barcode@agilent.com con il numero di serie dello 
scanner indicato nel testo della mail per ricevere 
prontamente una licenza. Questa licenza dovrà essere 
rinnovata ogni anno. 

2 Una volta ricevuta la licenza, posizionarla nella seguente 
directory:

C:\ProgramFiles\Agilent\Microarray

3 Chiudere e riavviare il software Scan Control.

Lo scanner riconoscerà la nuova licenza.
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Messa in funzione dello Scanner

Operazione 1. Accendere lo scanner per microarray Agilent
4 Accendere lo scanner per microarray tramite l’interruttore 

sul lato anteriore dello strumento. Si noterà che:

a Si aziona una ventola e il coperchio si chiude.

b Lo scanner per microarray avvia una routine di 
inizializzazione che dura circa quattro minuti. Durante 
l’inizializzazione viene eseguito un auto-test; mentre 
vengono effettuati i diversi controlli funzionali gli 
indicatori luminosi di stato lampeggiano.

c I laser non si attiveranno fino a quando non viene avviato 
il software Scan Control.

Figura 5 Posizione dell’interruttore di accensione e degli indicatori 
luminosi di stato

Per istruzioni su come impostare 
l'accensione e lo spegnimento 
automatico dei laser, vedere 
“Impostazione dell'ora per 
accendere e spegnere i laser” a 
pagina 63 nel capitolo 4.

5 Fare doppio clic sull’icona Agilent Scan Control per aprire il 
programma Scan Control.

Oppure

Selezionare Start > All Programs > Agilent > Scan Control.

Figura 6 Icona Agilent Scan Control 

Quando viene avviato il programma, i laser cominciano la 
fase di riscaldamento.

Indicatori 
luminosi di 
stato

Interruttore di 
accensione
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6 Controllare il messaggio relativo allo stato dello scanner sul 
bordo inferiore della finestra principale. 

Inizializzazione 
dello scanner

Lo scanner è in fase di inizializzazione. Quando 
l’inizializzazione è ultimata, il coperchio dello scanner si 
sblocca e i laser continuano il riscaldamento.

I laser sono in 
fase di 

riscaldamento

La fase di riscaldamento dei laser dura circa 30 minuti. In attesa 
che i laser completino il riscaldamento, passare all’“Operazione 
2. Inserire i vetrini nei portavetrini” a pagina 24.

I laser sono 
spenti

Per attivare i laser, selezionare Tools > Laser Auto ON/OFF 
Settings... e fare clic su Turn Lasers ON Now. 

Scanner pronto È possibile cominciare la scansione.

Per poter avviare il ciclo del caricatore circolare è necessario 
che entrambi i laser abbiano ultimato il riscaldamento. 

Figura 7 Finestra principale Scan Control visualizzata quando i laser 
sono pronti
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Operazione 2. Inserire i vetrini nei portavetrini

Un vetrino deve essere inserito in un portavetrini prima di 
essere caricato nel caricatore circolare. Il portavetrini protegge 
il vetrino durante la scansione. 

Figura 8 Caricamento dei vetrini nel portavetrini

Le impronte digitali causano errori 
nella rilevazione della fluorescenza. 
Per una lettura precisa, usare 
sempre i guanti quando si 
maneggiano i vetrini, facendo 
attenzione a toccare solo i bordi.  
 
Evitare, inoltre, di scrivere con 
pennarelli o di applicare etichette 
sui vetrini, fatta eccezione per 
l’apposito codice a barre.

1 Tenere il portavetrini per i lati con il logo Agilent rivolto 
verso l’alto.

2 Appoggiare un pollice al centro della copertura del 
portavetrini.

3 Esercitare una lieve pressione sulla copertura spingendo 
verso l’estremità superiore del portavetrini, fino ad avvertire 
lo scatto di sblocco.

Per istruzioni dettagliate su come rimuovere i vetrini, vedere 
“Operazione 5. Rimozione dei vetrini” a pagina 33.



Operazioni preliminari 2 
Operazione 1. Accendere lo scanner per microarray Agilent

Guida all'uso dello Scanner per microarray Agilent G2565CA (software Scan Control 8.3) 25

Figura 9 Sbloccare la copertura

4 Posizionare il vetrino nel portavetrini in modo tale che l’estremità 
del vetrino appoggi perfettamente sul supporto posteriore.

La superficie attiva del microarray deve essere rivolta verso l'alto.

Figura 10 Posizionamento corretto del vetrino sul supporto

Copertura del 
portavetrini 
sbloccata

Supporto per 
portavetrini

Superficie attiva del 
microarray
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5 Allineare il vetrino al portavetrini osservando le due regole 
seguenti:

• Posizionare sul supporto posteriore l’estremità del vetrino 
priva dell’etichetta con il codice a barre.

• La superficie del vetrino su cui è depositato il microarray 
è rivolta verso la copertura. Il microarray viene scansito 
attraverso il vetro.

Osservare sempre queste regole quando si esegue 
l’allineamento dei vetrini.

I vetrini Agilent hanno due codici a barre, uno su ciascun 
lato del vetro. Vedere Figura 11. In genere i vetrini non 
Agilent hanno un solo codice a barre. Posizionare il vetrino 
con il lato attivo, su cui è presente il microarray, rivolto verso 
la copertura del portavetrini. 

Vedere “Specifiche dei codici a 
barre e delle etichette con codice a 
barre” a pagina 99 per le istruzioni 
su come applicare un secondo 
codice a barre leggibile.

Se l’array individuato si trova sul lato del vetrino opposto a 
quello del codice a barre, lo scanner non è in grado di leggere 
il codice a barre.

Figura 11 Lati del vetrino

AT T E N Z I O N E Un vetrino inserito in modo scorretto può danneggiare lo scanner per 
microarray.
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6 Lasciare l’altra estremità del vetrino facendolo scivolare nel 
portavetrini. 

Il vetrino in posizione corretta è lievemente inclinato contro 
le linguette laterali del portavetrini.

Figura 12 Scivolamento del vetrino nel portavetrini

7 Per chiudere la copertura del portavetrini, premere 
delicatamente con il pollice sulla copertura. 

Figura 13 Chiudere la copertura

8 Per bloccare la copertura, spingere indietro delicatamente la 
copertura con il pollice fino a percepire lo scatto di blocco. 

Linguetta
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Figura 14 Blocco della copertura

9 Verificare che il coperchio del portavetrini sia perfettamente 
chiuso.

Figura 15 Copertura bloccata correttamente

Copertura bloccata 
sotto le linguette 
laterali
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Operazione 3. Caricamento dei portavetrini nel caricatore circolare
Quando i vetrini sono correttamente inseriti nei portavetrini, è 
possibile caricare i portavetrini nel caricatore circolare. Il 
caricatore circolare è concepito in modo da facilitare 
l’inserimento corretto dei portavetrini. È possibile caricare i 
portavetrini sia quando il caricatore si trova nello scanner o 
quando è rimosso dallo scanner.

Lo scanner per microarray esegue 
la scansione dei vetrini nell’ordine 
in cui questi vengono rilevati 
durante la rotazione del caricatore 
circolare, dagli slot con i numeri 
inferiori a quelli con i numeri 
superiori. Il ciclo del caricatore 
salta gli slot vuoti.

1 Caricare un portavetrini nello slot 1 del caricatore circolare, 
il primo slot localizzato in senso orario a partire dalla 
posizione iniziale.

Non posizionare vetrini nello slot di partenza del caricatore 
circolare. Lo slot di partenza è più grande degli altri ed è 
contrassegnato dall’etichetta “Home”.

2 Accertarsi che il lato più sottile del portavetrini sia rivolto 
verso il centro del caricatore circolare. 

3 Accertarsi che l’estremità inferiore del portavetrini sia a 
contatto con il fondo dello slot del caricatore circolare. 

Figura 16 Caricatore circolare

4 Se il caricatore circolare è già installato, passare all'operazione 5.

In caso contrario installare il caricatore circolare.

Slot di 
partenza

Slot 1

Il lato più 
sottile è rivolto 
verso il centro

AT T E N Z I O N E Un posizionamento scorretto del portavetrini nel caricatore circolare 
può causare gravi danni allo scanner per microarray.
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Se i portavetrini sono stati posizionati in un caricatore circolare 
precedentemente rimosso dallo scanner per microarray, seguire 
le operazioni seguenti per rimontare il caricatore. 

a Montare il caricatore in modo che i fori di allineamento 
del caricatore siano posizionati sopra i perni di 
allineamento dello scanner per microarray nell’area 
destinata ad accogliere il caricatore.

Allineare il foro a forma di D sul fondo del caricatore con il 
supporto centrale a forma di D della parte superiore dello 
scanner (dove va collocato il caricatore) e posizionare 
delicatamente il caricatore nello scanner in posizione verticale. 

b Accertarsi che il caricatore sia correttamente posizionato.

5 (Opzionale) Coprire il caricatore circolare con l’apposita 
copertura fino a percepire lo scatto di inserimento delle due 
linguette laterali.

Figura 17 Copertura del caricatore circolare

6 Chiudere il coperchio dello scanner.

AT T E N Z I O N E Durante il montaggio del caricatore, evitare con cura di farlo urtare 
conto il braccio di caricamento automatico. Questo, infatti, potrebbe 
causare un disallineamento.

AT T E N Z I O N E Se il caricatore deve essere ruotato manualmente, accertarsi prima 
che lo scanner sia spento per evitare di danneggiare lo strumento.

Linguette

Slot di 
partenza
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Non è possibile eseguire le operazioni seguenti senza aver 
prima chiuso il coperchio.

• Inizializzazione dello scanner

• Verificare la presenza di slot vuoti nel caricatore circolare

• Leggere i codici a barre prima di avviare il caricatore 
circolare

• Avviare un ciclo del caricatore circolare

Figura 18 Allineamento di perni e fori sullo scanner e sul caricatore

Se nel Carousel Log Report viene visualizzato un messaggio 
d’errore che segnala un timeout del motore, il problema 
potrebbe essere dovuto al montaggio scorretto del caricatore. 
Verificare l’allineamento del caricatore e ripetere il montaggio, 
se necessario.

Perni di allineamento fissi

Perno di allineamento mobile

Fori per perni di allineamento fissi

Foro per perno di allineamento mobile



32 Guida all'uso dello Scanner per microarray Agilent G2565CA (software Scan Control 8.3)

2 Operazioni preliminari 
Operazione 1. Accendere lo scanner per microarray Agilent 

Operazione 4. Scansione dei vetrini

Una scansione consiste nella 
creazione di un'immagine delle sonde 

su un singolo vetrino. Un ciclo del 
caricatore circolare consiste nella 

scansione di tutti i vetrini specificati 
presenti nel caricatore.

Effettuare i seguenti passaggi per preparare i vetrini per la 
scansione ed avviare il ciclo del caricatore circolare. Vedere la 
sezione successiva, “Scansione dei vetrini”, per istruzioni più 
dettagliate.

“Operazione 1. Impostazione della posizione degli slot” a 
pagina 36

“Operazione 2. Impostazione di un profilo per la modifica di 
tutte le impostazioni nella tabella di scansione” a pagina 37

“Operazione 3. Modifica delle impostazioni di scansione nella 
tabella di scansione” a pagina 38

“Operazione 4. Avvio del ciclo del caricatore circolare” a 
pagina 39

“Operazione 5. Trasferimento dei file e archiviazione dei dati” a 
pagina 42
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Operazione 5. Rimozione dei vetrini

Quando il ciclo del caricatore circolare è completato, è possibile 
rimuovere i portavetrini dal caricatore e quindi rimuovere i 
vetrini dal portavetrini.

1 (Opzionale) Rimuovere il caricatore circolare dallo scanner.

Se il braccio di caricamento automatico dei portavetrini è 
esteso nel caricatore, non rimuovere il caricatore. Seguire 
invece le istruzioni contenute in “Risoluzione dei problemi 
del braccio di caricamento automatico esteso nel 
caricatore” a pagina 82.

2 Rimuovere i portavetrini dal caricatore.

3 Rimuovere i vetrini dal portavetrini.

a Tenere il portavetrini per i lati con il logo Agilent rivolto 
verso l’alto.

b Appoggiare un pollice al centro della copertura del 
portavetrini.

c Esercitare una lieve pressione sulla copertura spingendo 
verso l’estremità superiore del portavetrini, fino ad 
avvertire lo scatto di sblocco.

Copertura del 
portavetrini 
sbloccata
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d Spingere l’estremità del vetrino con il codice a barre da 
sotto la copertura del vetrino, per evitare di lasciare 
impronte sull’area del campione.

e Prendere il vetrino appoggiando le dita sui lati e 
rimuoverlo dal portavetrini.

Figura 19 Rimozione corretta del vetrino

Spingere verso l’alto 
da sotto
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Operazione 6. Impostazione dello spegnimento automatico 
dei laser 

È possibile prolungare la durata del laser impostando lo 
spegnimento automatico dei laser in determinati orari. Vedere 
“Impostazione dell'ora per accendere e spegnere i laser” a 
pagina 63 al Capitolo 4, “Utilizzo degli strumenti”, per ulteriori 
informazioni.

Non è necessario spegnere lo scanner per microarray.

Nel caso si desideri spegnere lo scanner, seguire queste 
istruzioni:

1 Fare clic su Exit nella finestra principale Scan Control.

Per evitare blocchi intermittenti della comunicazione, 
chiudere il programma Scan Control prima di spegnere lo 
scanner per microarray.

2 Attendere qualche secondo e verificare che il coperchio dello 
scanner per microarray sia sbloccato.

3 Sollevare il coperchio.

4 Spegnere lo scanner per microarray con l’interruttore di 
accensione situato sul lato anteriore.

AT T E N Z I O N E Evitare qualsiasi tentativo di sollevare il coperchio prima di aver udito 
lo scatto di sblocco. Tentare di sollevare il coperchio durante la fase di 
sblocco può provocare l’inceppamento dello scanner per microarray.
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Scansione dei vetrini

Operazione 1. Impostazione della posizione degli slot
Se si desidera eseguire la scansione dei vetrini in tutti i 48 slot, 
saltare all’“Operazione 2. Impostazione di un profilo per la 
modifica di tutte le impostazioni nella tabella di scansione” a 
pagina 37.

1 Nella casella Start slot, selezionare il numero dello slot in cui 
si trova il primo vetrino che si desidera scansire.

2 Nella casella End slot, selezionare il numero dello slot in cui 
si trova l’ultimo vetrino che si desidera scansire.

L’intervallo di slot inserito con le operazioni 1 e 2 condiziona la 
maggior parte delle funzioni della finestra principale Scan Control. 

• Nella tabella di scansione viene visualizzato solo l’intervallo 
di slot inserito in questa fase.

• Lo scanner esegue solo la scansione dei vetrini nell’intervallo 
di slot inserito in questa fase.

• Il comando Carousel Check esegue un controllo solo 
sull'intervallo di slot inserito in questa fase per gli slot vuoti 
e per i codici a barre supportati da Agilent. (Vedere 
“Controllo per individuare i codici a barre supportati da 
Agilent gli slot vuoti” a pagina 49 al Capitolo 3).
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Operazione 2. Impostazione di un profilo per la modifica di 
tutte le impostazioni nella tabella di scansione

• Dall'elenco dei profili, selezionare uno dei profili esistenti.

Un profilo è un insieme di impostazioni 
di scansione e immagine che, se 
selezionato, popola la tabella di 

scansione con i valori immessi in 
Profile Editor. 

Quando si apre la finestra principale Scan Control, è possibile 
vedere nelle colonne i valori delle impostazioni di scansione. 
Questi valori sono stati impostati in base all'ultimo profilo 
selezionato per un ciclo prima di chiudere il programma.

Agilent fornisce sei profili predefiniti per l'uso con i microarray 
ad alta densità Agilent, i microarray Agilent G3 e i microarray 
non Agilent.

<predefinite> Impostazioni predefinite visualizzate dopo l'installazione del 
programma

AgilentHD_GX_2Color Microarray di espressione genetica Agilent HD a 2 colori

AgilentHD_GX_1Color Microarray di espressione genetica Agilent HD a 1 colore

AgilentHD_CGH Microarray Agilent HD CGH/CNV/ChIP

AgilentHD_miRNA Microarray Agilent HD miRNA

AgilentG3_CGH Microarray Agilent G3 CGH/CNV/ChIP

Per modificare tutte le impostazioni contemporaneamente è 
possibile selezionare uno dei profili Agilent o crearne uno proprio 
da uno qualunque dei profili esistenti, incluso il profilo <Default>. 

Per modificare un profilo esistente o creare un proprio profilo, 
vedere il capitolo 4, “Modifica di un profilo esistente” a 
pagina 55 o “Creazione di un nuovo profilo” a pagina 56.
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Operazione 3. Modifica delle impostazioni di scansione nella 
tabella di scansione

Se non è necessario modificare nessuna impostazione nella 
tabella di scansione prodotta dal profilo selezionato, attendere 
fino a quando il messaggio di stato dello scanner indica che lo 
scanner è pronto e passare all'“Operazione 4. Avvio del ciclo del 
caricatore circolare” a pagina 39. 

1 Fare clic sulle celle che si desidera modificare.

• Fare clic su una cella singola, o

• Fare clic sull'intestazione di una colonna, o

• Trascinare il cursore su celle multiple in una colonna per 
selezionare celle contigue. Sulla destra della prima cella 
selezionata verrà visualizzata una freccia.

• Premere Ctrl e selezionare celle non contigue all'interno di 
una colonna, una per volta. Sulla destra dell'ultima cella 
selezionata verrà visualizzata una freccia.

2 Selezionare una nuova impostazione dall'elenco.

La nuova impostazione viene visualizzata in grassetto.

.

NOTA Una stima della dimensione totale del file e del tempo di esecuzione è 
riportata nella riga di stato in fondo alla finestra principale Scan Control. È 
richiesto spazio sull'unità C: per i file temporanei generati durante la 
scansione. Se la dimensione stimata dell'immagine più la dimensione del 
file temporaneo eccede lo spazio disponibile, lo scanner non consentirà 
l'avvio del ciclo del caricatore.

AT T E N Z I O N E Agilent consiglia di selezionare un percorso di output per 
l'archiviazione dei file di immagine su un'unità locale. Se si seleziona 
un'unità di rete per il percorso di output, e la connessione di rete non 
riesce, i file vengono salvati sull'unità C: locale nel file  
Program Files\Agilent\Microarray\NetDataBackup.
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Operazione 4. Avvio del ciclo del caricatore circolare

Durante un ciclo del caricatore vengono scansiti tutti i vetrini 
selezionati presenti nel caricatore.

1 Verificare che il messaggio relativo allo stato dello scanner 
nella finestra principale visualizzi Scanner Ready.

Il ciclo del caricatore non può essere avviato finché i laser 
non hanno completato la fase di riscaldamento.

2 Fare clic su Scan Slot m-n nella finestra principale Scan Control.

La lettera m rappresenta lo slot iniziale in cui è posizionato il 
primo vetrino e la lettera n rappresenta lo slot finale in cui è 
posizionato l’ultimo vetrino.

All’avvio della scansione hanno luogo due azioni:

• il coperchio dello scanner si blocca; 

• si apre la finestra di dialogo Scan Progress che visualizza 
lo stato della scansione. 

Figura 20 Finestra di dialogo Scan Progress
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I messaggi nella casella Status della finestra di dialogo Scan 
Progress informano l’utente sull’avanzamento di ciascuna 
scansione e del ciclo del caricatore. 

Quando il ciclo del caricatore è completato, la casella Status 
visualizza il messaggio Carousel run completed. 

Il Carousel Report Log presenta le 
informazioni di scansione e i messaggi 

di errore che si verificano durante il 
ciclo di esecuzione del caricatore.

Il log di report viene visualizzato automaticamente al termine di 
un ciclo del caricatore.

Figura 21 Carousel Report Log

Se si desidera aprire nuovamente il Carousel Report Log finale 
dopo aver chiuso la finestra di dialogo Scan Progress, è 
reperibile seguendo il percorso:

C:\Program Files\Agilent\Microarray\Logs\CarouselRunLog.htm

Il file viene sovrascritto ogni volta che si avvia un nuovo ciclo 
del caricatore. 

Una volta completato il ciclo, è possibile rimuovere i vetrini. 
Vedere “Operazione 5. Rimozione dei vetrini” a pagina 33.
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Visualizzazione del Carousel Report Log durante il ciclo 

È possibile visualizzare il Carousel Report Log in qualunque 
momento durante il ciclo del caricatore. 

• Fare clic su View Report nella finestra di dialogo Scan Progress.

Controllo dei dati durante o dopo il ciclo

Consultare la Guida rapida del 
software Feature Extraction, 
inclusa nei materiali forniti con lo 
scanner.

• Una volta trasferiti tutti i dati relativi a una scansione, 
visualizzare il file nel software Agilent Feature Extraction o 
in un altro programma. 

Annullamento di una scansione

In qualsiasi momento è possibile interrompere la scansione o il 
ciclo del caricatore. 

• Fare clic sul pulsante Abort nella finestra di dialogo Scan 
Progress. 

Viene visualizzato il seguente messaggio.

Figura 22 Messaggio relativo all’annullamento del ciclo del caricatore

Lo scanner per microarray impiega uno o due minuti per 
portare a termine l’annullamento della scansione anche se è 
stato selezionato Yes. Tutti i dati raccolti vengono salvati per le 
analisi successive. 

NOTA Se Feature Extraction 10.x è stato installato su un altro disco fisso, è 
necessario trasferire i file di immagine su questa unità dopo il ciclo. Vedere 
“Operazione 5. Trasferimento dei file e archiviazione dei dati” a pagina 42.
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Operazione 5. Trasferimento dei file e archiviazione dei dati

• Al termine del ciclo, trasferire i file in un’altra cartella, se 
necessario.

Sono disponibili quattro opzioni per il salvataggio dei file:

• Nuova cartella nella cartella originale sull’unità locale 
impostata per il percorso di output

• Un’altra cartella sull’unità locale

• Cartella in rete

È necessario trasferire i dati sul PC su cui è stato 
installato il programma Feature Extraction.

• CD o DVD

In ogni stazione di lavoro è incluso uno scrittore DVD.

AT T E N Z I O N E È importante archiviare regolarmente i dati dal PC dello scanner per 
assicurarsi che ci sia spazio su disco sufficiente per i cicli futuri. 
Quando il disco è quasi pieno, lo scanner per microarray interrompe la 
scansione e viene visualizzato un messaggio di attenzione. 

È possibile migliorare le prestazioni deframmentando regolarmente 
l'unità disco.
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Può accadere che, prima di effettuare la scansione di una serie 
di vetrini, l’utente desideri modificare le impostazioni di 
scansione o di immagine.

In questo capitolo viene descritta ciascuna impostazione della 
tabella di scansione, poi vengono fornite informazioni su come 
modificarle tutte contemporaneamente o una per volta.
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Modifica delle impostazioni della tabella di scansione

È possibile modificare le impostazioni della tabella di scansione 
in due modi:

Un profilo è un insieme di impostazioni 
di scansione e immagine che, se 
selezionato, popola la tabella di 

scansione con i valori immessi in 
Profile Editor. 

• Modifica di tutte le impostazioni contemporaneamente 
mediante profili

• Modifica delle impostazioni individuali di scansione 
mediante menu a discesa nella tabella di scansione

Sebbene sia possibile modificare le voci nell'ordine che si 
preferisce, per risparmiare tempo e possibile modificare le voci 
in questo ordine:

a Se si effettua la scansione di vetrini non Agilent, è 
possibile “Creazione di una nuova regione di scansione 
con Scan Region Editor” più pertinente per i vetrini 
utilizzati rispetto a quelle presenti nella tabella di 
scansione o nel Profile Editor.

b Se si effettua la scansione di vetrini Agilent o non Agilent, 
è possibile “Modifica delle impostazioni della tabella di 
scansione mediante profili” selezionando un profilo 
diverso.

c Dopo aver selezionato un profilo diverso (o modificato o 
creato un nuovo profilo), è possibile “Modifica delle 
impostazioni individuali della tabella di scansione”. 

Se si sceglie un profilo diverso dopo aver modificato 
singole voci, le voci del profilo sovrascriveranno quelle 
modificate singolarmente.

d Assicurarsi di inserire l'ID dei vetrini manualmente o 
automaticamente dopo aver selezionato un profilo. È 
necessario effettuare questa operazione per i vetrini senza 
codice a barre. È possibile effettuare questa operazione 
per i vetrini Agilent. Vedere “Slide ID” a pagina 48.

Per informazioni su ciascuna delle impostazioni di scansione, 
vedere “Impostazioni della tabella di scansione” a pagina 48.
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Modifica delle impostazioni della tabella di scansione 
mediante profili

• Dal menu a discesa Profile, selezionare il profilo di cui si 
desidera utilizzare le impostazioni durante il ciclo.

Figura 23 Menu a discesa sulla finestra principale Scan Control

È possibile modificare le impostazioni per il profilo selezionato 
(vedere “Modifica di un profilo esistente” a pagina 55) oppure 
creare un nuovo profilo partendo da esso (vedere “Creazione di 
un nuovo profilo” a pagina 56).

Quando si apre la finestra principale Scan Control, è possibile 
vedere nelle colonne i valori delle impostazioni di scansione. 
Questi valori sono stati impostati in base all'ultimo profilo 
selezionato per un ciclo prima di chiudere il programma.

Agilent fornisce sei profili predefiniti per l'uso con i microarray 
ad alta densità Agilent, i microarray Agilent G3 e i microarray 
non Agilent.

AgilentHD_GX_2Color Microarray di espressione genetica Agilent HD a 2 colore

AgilentHD_GX_1Color Microarray di espressione genetica Agilent HD a 1 colore

AgilentHD_CGH Microarray Agilent HD CGH/CNV/ChIP

AgilentHD_miRNA Microarray Agilent HD miRNA

AgilentG3_CGH Microarray Agilent G3 CGH/CNV/ChIP

Per i vetrini Agilent è possibile selezionare il profilo adatto al 
tipo utilizzato di microarray Agilent.

Per i vetrini non Agilent è necessario effettuare queste 
modifiche alle singole impostazioni della tabella di scansione. 
Oppure, è possibile creare un nuovo profilo da uno esistente. 
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Modifica delle impostazioni individuali della tabella di 
scansione 

Con questa tabella di scansione è possibile modificare le voci 
per vetrini individuali oppure gruppi di vetrini selezionando 
una voce dal menu a discesa di ciascuna colonna, eccetto per le 
colonne Slide ID e Description.

1 Fare clic sulle celle che si desidera modificare.

• Fare clic su una cella singola, o

• Fare clic sull'intestazione di una colonna, o

• Trascinare il cursore su celle multiple in una colonna per 
selezionare celle contigue.

Sulla destra della prima cella selezionata verrà 
visualizzata una freccia.

• Premere Ctrl e selezionare celle non contigue all'interno di 
una colonna, una per volta.

Sulla destra dell'ultima cella selezionata verrà visualizzata 
una freccia.

2 Fare clic sulla freccia per visualizzare il menu a discesa e 
selezionare l'impostazione.

Figura 24 Menu a discesa per le impostazioni delle regioni di scansione

Le impostazioni modificate vengono visualizzate in grassetto.

Vedere le descrizioni delle impostazioni di queste colonne in 
“Impostazioni della tabella di scansione” a pagina 48.
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Ripristino delle impostazioni della tabella di scansione ai valori 
correnti del profilo

I valori del profilo visualizzati dopo il ripristino sono i valori 
originali del profilo selezionato. 

1 Fare clic sulla cella o sulle celle di cui si intende ripristinare 
le impostazioni.

• Fare clic su una cella singola, o

• Fare clic sull'intestazione di una colonna, o

• Trascinare il cursore su celle multiple in una colonna per 
selezionare celle contigue, oppure

• Premere Ctrl e selezionare celle non contigue all'interno di 
una colonna, una per volta, oppure

• Fare clic sull'intestazione Slot nell’angolo superiore 
sinistro della tabella per selezionare tutte le celle della 
tabella di scansione.

2 Fare clic con il tasto destro del mouse sull'area selezionata e 
scegliere Reset to Profile Value.

Figura 25 Menu di scelta rapida per ripristinare i valori originali delle 
impostazioni selezionate nel profilo corrente

Le impostazioni nel profilo corrente vengono visualizzate 
nell'area selezionata.
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Impostazioni della tabella di scansione

Questa sezione descrive le impostazioni nella tabella di 
scansione che possono essere modificate. La prossima sezione 
fornisce informazioni su come modificarle.

Figura 26 Finestra principale Scan Control e tabella di scansione con impostazioni di profilo predefinite

Slide ID Identificatore del vetrino. Le voci Slide ID vengono utilizzate 
come parte del nome del file di immagine se specificato come 
parte del nome del file nel profilo corrente. Vedere “Naming 
prefix 1 e Naming prefix 2” a pagina 56.

Inserimento automatico Se i vetrini dispongono di codici a 
barre conformi alle specifiche contenute nelle “Specifiche dei 
codici a barre e delle etichette con codice a barre” a pagina 99, 
non è necessario inserire l'ID del vetrino nella tabella di 
scansione prima di avviare il ciclo del caricatore. La funzione 
“Auto detect” nella colonna Slide ID significa che lo scanner 
legge automaticamente i codici a barre supportati da Agilent 
nella tabella di scansione alla scansione di ciascun vetrino. 

È possibile inoltre inserire manualmente l'identificativo del vetrino. 

Inserimento manuale È necessario inserire l'ID per i vetrini 
senza codice a barre, oppure i vetrini con codici a barre di 
formato non supportato, utilizzando la tastiera o un apposito 
lettore di codice a a barre esterno.
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Se si inserisce l'identificativo mediante la tastiera, fare doppio 
clic sulla cella Slide ID prima di digitare il codice a barre o un 
identificativo di testo univoco.

Controllo per individuare i codici a barre supportati da Agilent gli slot 
vuoti Per visualizzare i codici a barre supportati da Agilent e 
individuare gli slot vuori nella colonna Slide ID, fare clic su 
Tools > Carousel Check.

Il programma prima controlla il caricatore circolare per 
individuare gli slot vuoti e indica “No chip” in ciascuna Slide 
ID senza vetrino. Quindi legge i codici a barre per tutti i 
vetrini e li indica nelle celle Slide ID.

Dye channel Definisce se vengono raccolte solo le informazioni del canale di 
colorazione rosso (per esempio, colorazione Cy-5), solo quelle del 
canale di colorazione verde (per esempio, colorazione Cy-3) o di 
entrambi i canali. La selezione non ha alcun effetto sul tempo di 
scansione, ma selezionando solo un canale di colorazione si 
riducono le dimensioni del file fino a un fattore di 2.

Scan region La regione di scansione definisce l’area del vetrino che deve 
essere scansita. Deve essere sufficientemente grande da 
acquisire l’intera area di stampa del microarray. Dev’essere 
abbastanza piccola da evitare che la scansione si avvicini 
troppo al codice a barre o ai bordi non trasparenti del vetrino, 
compromettendo la capacità di autofocus dello scanner. 
Riducendo al minimo la regione di scansione si riduce il tempo 
di scansione e si risparmia spazio di archiviazione.

Agilent fornisce una regione di scansione adatta a tutti i vetrini 
Agilent High Density e G3, e un'altra regione adatta alla scansione 
di vetrini completi 1 x 3 senza etichetta con codice a barre.

Per i vetrino non Agilent, può essere necessario utilizzare una 
regione di scansione personalizzata più adatta alla regione 
stampata. Vedere “Creazione di una nuova regione di scansione 
con Scan Region Editor” a pagina 60.

Scan resolution 
(µm)

Imposta la risoluzione di scansione (dimensione dei pixel) su 
2,3, 5 o 10 micron. 

Per le scansioni a 10 micron, ciascuna riga di pixel 
nell'immagine TIFF rappresenta la media di due linee di 
scansione, una acquisita in ciascuna direzione. Per le scansioni 
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a 5, 3 e 2 micron, è possibile scegliere di ottenere questa media 
con la scansione con doppia passata, oppure acquisire una sola 
linea di scansione per ciascuna riga di immagine.

Intervallo 
dinamico file 

TIFF

Imposta l'intervallo dinamico a 16 bit o 20 bit. Lo scanner 
G2565CA ha esteso l'intervallo dinamico del PMT e 
dell'elettronica di elaborazione del segnale. Selezionando 
l'opzione di file TIFF a 20 bit, è possibile accedere a questo 
intervallo esteso, per consentire la quantificazione delle 
caratteristiche di segnale alto e basso in una sola scansione.

Il software Scan Control consente ancora la tradizionale 
scansione XDR a 16 bit, come descritto di seguito.

La tabella riportata qui sotto indica lo spazio di archiviazione e il 
tempo di scansione per scansioni con passata singola e doppia per 
ciascuna risoluzione selezionata ad un intervallo dinamico TIFF di 
16 bit o di 20 bit. La regione di scansione è di 61 X 21,6 mm. 

La barra di stato in fondo alla finestra principale Scan Control indica 
una stima dello spazio di archiviazione e del tempo di esecuzione 
necessari per completare l'intero ciclo del caricatore di vetrini.

Le scansioni con doppia passata non richiedono uno spazio di 
archiviazione maggiore rispetto alle scansioni con passata 
singola, ma richiedono il doppio del tempo. 

Tabella 1 Spazio di archiviazione e tempo di scansione per scansioni con 
passata singola e doppia per la regione di scansione Agilent HD 
61 x 21,6 mm

Risoluzione Spazio di 
archiviazione, 
Mb, 16 bit

Spazio di 
archiviazione, 
Mb, 20 bit

Tempo di 
scansione, 
min.

Passata singola a 2 micron 1300 1600 20

Passata singola a 3 micron 620 760 15

Passata singola a 5 micron 200 300 8

Passata singola a 10 micron 52 115 8

Passata doppia a 2 micron 1300 1600 40

Passata doppia a 3 micron 620 760 30

Passata doppia a 5 micron 200 300 16
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Red PMT Gain 
e 

Green PMT Gain

Imposta il livello di sensibilità del PMT del canale rosso e del 
canale verde. Il PMT rileva la fluorescenza emessa dal 
microarray. 

Il livello di output predefinito (100%) imposta il guadagno al 
livello calibrato in fabbrica; si tratta dell'impostazione 
consigliata per i microarray Agilent. È possibile ridurre 
indipendentemente ciascuna impostazione dei canali di 
colorazione fino all’1%.

Se un microarray è così luminoso da causare la saturazione 
dell’estremità superiore del segnale di output, il livello di 
sensibilità del PMT può essere ridotto a un intervallo di 
sensibilità che consenta la lettura di tutte le informazioni. 

Rapporto XDR Prima della disponibilità dell'intervallo dinamico per il file TIFF 
a 20 bit, era necessario utilizzare la funzione eXtended Dynamic 
Range sia sullo scanner che sul software Feature Extraction per 
acquisire tutti i dati scansiti tra le funzionalità con segnale 
molto basso e le funzionalità con segnale molto elevato. Ora è 
possibile selezionare l'intervallo dinamico per il file TIFF a 20 
bit per acquisire l'ampia gamma dinamica di dati come 
alternativa all'utilizzo della funzione XDR.

Con la funzione XDR attivata, lo scanner automaticamente 
scansisce due volte lo stesso vetrino a due diversi livelli di 
sensibilità PMT. Questo genera due immagini collegate che 
Feature Extraction può elaborare contemporaneamente per 
produrre un singolo set unificato di dati di intensità estratti che 
coprono fino a 6+ ordini di grandezza. 

Il livello di sensibilità elevato è impostato dal Red o Green PMT 
Gain. La funzione XDR viene disattivata automaticamente (una 
volta attivata) per valori inferiori a 10%.

L'impostazione della colonna del rapporto XDR comunica allo 
scanner di eseguire una seconda scansione ad impostazioni 
PMT inferiori. Ad esempio, se Red e Green PMT sono impostati 
su 100%, e il rapporto XDR è impostato su 0,1, la seconda 
scansione verrà effettuata con PMT impostati su 10%. 
L'impostazione PMT più bassa disponibile è 1%.
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Output path Il pulsante Browse consente di selezionare una directory per 
archiviare i dati di ciascuna scansione. Agilent consiglia di 
acquisire i dati in una directory locale su un disco fisso 
secondario. È possibile selezionare anche una directory di rete. 
Se si verifica un problema di accesso di rete durante la 
scansione, i dati verranno salvati in una directory locale 
temporanea e verrà incluso un messaggio di avvertenza nel 
report del ciclo del caricatore circolare.

Slide 
Description

Descrizione di ciascun vetrino in fase di scansione. Queste 
informazioni diventano parte delle informazioni sul file, 
visualizzabili nel software Feature Extraction. 
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Se si desidera creare o modificare un profilo o una regione di 
scansione o se si intende impostare l'ora di accensione e 
spegnimento automatici dei laser, è necessario utilizzare gli 
strumenti del menu Tools. Questo capitolo illustra l'uso di 
questi tool:

Figura 27 Menu Tools
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Profile Editor Con Profile Editor è possibile modificare le impostazioni per 
ciascuno dei profili forniti con il software: 

<Default> Il profilo le cui impostazioni vengono visualizzate all'installazione

AgilentHD_GX_
2Color 

Microarray di espressione genetica Agilent HD a 2 colore

AgilentHD_GX_1Color Microarray di espressione genetica Agilent HD a 1 colore

AgilentHD_CGH Microarray Agilent HD CGH/CNV/ChIP

AgilentHD_miRNA Microarray Agilent HD miRNA

AgilentG3_CGH Microarray Agilent G3 CGH/CNV/ChIP

Inoltre è possibile creare nuovi profili partendo da quelli esistenti.

Scan Region 
Editor

Può essere necessario effettuare la scansione di regioni di 
microarray non installate come impostazione predefinita. Per 
crearne di nuove, utilizzare Scan Region Editor.

Lasers Auto 
On/Off Settings

Per prolungare la durata dei laser, è possibile impostare l'ora di 
accensione e spegnimento automatici dei laser in questa 
finestra di dialogo.
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Creazione/modifica dei profili utilizzando Profile Editor

Modifica di un profilo esistente
È possibile modificare e salvare un profilo esistente. Oppure è 
possibile modificare un profilo esistente e salvare le modifiche 
con un nuovo nome per il profilo. (Vedere “Creazione di un 
nuovo profilo” a pagina 56).

1 Selezionare Tools > Profile Editor dalla barra del menu 
(Figura 27).

Figura 28 Profile Editor 

Non è consentito rimuovere il 
profilo <default> dall'elenco. È 
possibile rimuovere tutti gli altri, 
inclusi i profili creati a partire dal 
profilo <default>.

2 Selezionare un profilo da modificare.
3 Modificare le impostazioni di scansione e immagine 

utilizzando le scelte descritte in “Modifica delle impostazioni 
della tabella di scansione” a pagina 44 e “Impostazioni dei 
profili non presenti nella tabella di scansione” a pagina 56.

4 Fare clic su Save.
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Creazione di un nuovo profilo
È possibile creare un nuovo profilo da un profilo esistente 
salvando il profilo esistente con un nuovo nome.

1 Selezionare Tools > Profile Editor.

2 Selezionare un profilo esistente per salvarlo come nuovo.

3 Fare clic su Save As per salvare il file esistente con un nuovo 
nome.

4 Inserire il nome, poi fare clic su Save.

5 Modificare le impostazioni di scansione e immagine 
utilizzando le scelte descritte in “Modifica delle impostazioni 
della tabella di scansione” a pagina 44 e “Impostazioni dei 
profili non presenti nella tabella di scansione” a pagina 56.

6 Fare clic su Save.

Impostazioni dei profili non presenti nella tabella di scansione
Le seguenti impostazioni non sono visualizzate nella tabella di 
scansione. Questi parametri sono applicabili a tutte le scansioni 
nel ciclo del caricatore circolare.

Naming prefix 1 
e 

Naming prefix 2

Per le scansioni standard, il programma Scan Control utilizza 
tre segmenti di nome per comporre il nome del file. 

Prefix1_Prefix2_ScanNumber.tif.

Per le scansioni XDR, un segmento aggiuntivo (_H o _L) viene 
aggiunto al nome file per distinguere l’immagine XDR Hi 
dall’immagine XDR Lo:

Prefix1_Prefix2_ScanNumber_H.tif 
Prefix1_Prefix2_ScanNumber_L.tif

Il Prefix1 predefinito è Instrument Serial #, ma è possibile 
selezionare Slide ID o il proprio prefisso personalizzato.

Il Prefix2 predefinito è Slide ID, ma è possibile selezionare Slot #, 
Scan Date Time o il proprio prefisso personalizzato. 
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• Slide ID – Se selezionata, la voce nella cella Slide ID 
compare nel nome del file. Se <Auto detect> si trova nella 
cella Slide ID, il codice a barre comparirà nel nome file.

• Slot # – Il numero dello slot in cui si trova il vetrino scansito.

• Scan DateTime – Se si seleziona questa opzione, verranno 
utilizzate la data e l'ora in formato AAAAMMGGOOMM. 

• Customize – Se si seleziona Customize, inserire un prefisso 
personalizzato (massimo 36 caratteri).

Il programma Scan Control assegna automaticamente lo Scan 
Number. 

Il programma confronta il nome file di una nuova scansione 
con quelli nella directory di dati selezionata. 

Se Prefix1_Prefix2 è univoco, il numero di scansione viene 
impostato su S01.

Se si trova una corrispondenza, il numero di scansione viene 
aumentato fino ad ottenere un nome file unico. 

Esempio

US4510PP02_251485023883_S03.tif 

• Instrument Serial # = US4510PP02

• Slide ID = 251485023883

• ScanNumber = S03. Si tratta del terzo file di scansione nella 
directory con lo stesso Instrument Serial # e Slide ID.

Compress TIFF È possibile ridurre la quantità finale di spazio di archiviazione 
occupato dalle immagini di scansione comprimendo i file TIFF. 

L’algoritmo di compressione utilizzato, LZW, riduce lo spazio di 
archiviazione del 20 - 70%. 
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Split/rotate 
image

Alcuni programmi di analisi utilizzano dati ottenuti da 
immagini ad una sola colorazione e ruotate di 90 gradi. Se si 
imposta l'opzione Split/Rotate su Yes, il file colore viene diviso 
in due file colore e le immagini vengono ruotate di 90 gradi e 
capovolte. 

Si veda qui di seguito un esempio dell’immagine:

Ai file divisi vengono attribuiti i nomi FileName_green e 
FileName_red, dove FileName è il nome assegnato 
automaticamente al file prima della divisione.

Se è stato selezionato un solo canale di colorazione per il file di 
output, è necessario selezionare comunque questa casella per 
ruotare l’immagine, anche se non c’è la necessità di dividere il file.

Questa opzione è disponibile solo per le scansioni con intervallo 
dinamico TIFF a 16 bit. 
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Creazione/Modifica di regioni di scansione utilizzando Scan 
Region Editor

La regione di scansione definisce l’area del 
vetrino che deve essere scansita. Più la 

regione è grande, maggiore sarà il tempo 
di scansione. Le regioni di scansione 

possono variare a causa di fattori quali il 
posizionamento e le dimensioni 

dell’etichetta del codice a barre o la 
presenza di aree di vetro smerigliato.

Quando si utilizzano vetrini non Agilent, è possibile creare la 
propria regione di scansione o modificare una regione esistente 
fino alle dimensioni massime di 71 mm x 21,6 mm. La nuova 
regione viene visualizzata come selezione nella tabella di 
scansione e nel Profile Editor.

Avviare Scan Region Editor 

Dalla finestra principale Scan Control

• Selezionare Tools > Scan Region Editor dalla barra del 
menu (Figura 27).

Figura 29 Scan Region Editor 
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Dal menu Start

• Selezionare Start > Programs > Agilent Life Sciences > 
Scan Region Editor dalla barra delle applicazioni.

Non è possibile accedere alla voce di menu Scan Region Editor 
nella finestra principale quando lo scanner è in funzione. 
Tramite il menu Start è possibile solo creare e modificare nuove 
regioni di scansione. 

Creazione di una nuova regione di scansione con Scan 
Region Editor

Quando si crea una nuova regione di scansione o si utilizzano 
regioni di scansione esistenti, accertarsi che la regione di 
scansione si trovi a una distanza di almeno 4 mm dall’etichetta 
del codice a barre e non si sovrapponga ad altre aree opache o 
traslucide del vetrino.

1 Selezionare File > New Region dalla barra del menu 
all'interno di Scan Region Editor.

Figura 30 Finestra di dialogo Add New Region

2 Inserire il nome o le dimensioni della regione.
3 Inserire le misure in mm relative alla regione, utilizzando i 

criteri elencati sotto.
I valori non validi verranno contrassegnati in rosso.

X Misura dell’asse X per l’angolo superiore sinistro. Inserire 
questa misura e quella dell’asse Y in mm per posizionare la 
regione sul vetrino.
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Y Misura dell’asse Y per l’angolo superiore sinistro.

Width Larghezza della regione di scansione misurata dall’estremità 
dell’asse X nell’angolo superiore sinistro.

Height Altezza della regione di scansione misurata dall’estremità 
dell’asse Y nell’angolo superiore sinistro.

Ranges Intervallo di valori che possono essere inseriti per ogni misura. 

4 Fare clic su Save.

Se non vengono rilevati errori, viene visualizzato Scan Region 
Editor con l’elenco contenente la nuova regione di scansione. 

Figura 31 Elenco delle regioni di scansione 

Show Custom 
regions only

Quando questa casella è selezionata, nell’elenco di Scan 
Region Editor vengono visualizzate solo le regioni di 
scansione personalizzate. Se la casella è deselezionata, è 
possibile visualizzare nell’elenco anche le regioni fornite da 
Agilent. Queste regioni, tuttavia, non possono essere 
modificate con Scan Region Editor.

5 Chiudere Scan Region Editor.

Le nuove regioni create vengono ora visualizzate negli 
elenchi delle regioni di scansione, sia nella tabella di 
scansione che nel Profile Editor. 

Modifica di una regione di scansione esistente per vetrini 
non Agilent

È possibile modificare solo le regioni di scansione create 
dall’utente. Non è possibile modificare o rimuovere le regioni 
fornite da Agilent.
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Quando si crea una nuova regione di scansione o si utilizzano 
regioni di scansione esistenti, accertarsi che la regione di 
scansione si trovi a una distanza di almeno 4 mm dall’etichetta 
del codice a barre.

1 In Scan Region Editor, selezionare la regione da modificare.

2 Selezionare File > Open Region dalla barra del menu.

Viene visualizzata la finestra di dialogo Modify Region.

Figura 32 Finestra di dialogo Modify Region

3 Modificare il nome o le dimensioni della regione.

4 Modificare le misure relative alla regione, utilizzando i criteri 
elencati in “Creazione di una nuova regione di scansione con 
Scan Region Editor” a pagina 60.

5 Fare clic su Save.
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Impostazione dell'ora per accendere e spegnere i laser
Per estendere la durata dei laser dello scanner, è possibile impostare 
il programma Scan Control per l'accensione o lo spegnimento 
automatici dei laser. Questa caratteristica consente di impostare 
l’avvio del riscaldamento dei laser e della preparazione della 
scansione all’orario specificato oppure lo spegnimento automatico 
dei laser a un determinato orario o quando sono inattivi.

Indipendentemente dalle impostazioni Laser Auto ON/OFF:

• È possibile accendere o spegnere i laser manualmente in 
qualsiasi momento.

• All’avvio del programma Scan Control i laser si accendono. 

• Se all’orario specificato per lo spegnimento automatico, lo 
scanner sta effettuando una scansione, i laser rimarranno accesi.

Impostazione dell'accensione o dello spegnimento 
automatico dei laser

1 Selezionare Tools > Laser Auto ON/OFF Settings dalla 
barra del menu (Figura 27).

2 Fare doppio clic su No per impostare Enable laser auto 
ON/OFF su Yes.

Figura 33 Pagina delle proprietà Laser Auto ON/OFF Settings 
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Turn ON daily Selezionare Weekdays only o Weekends, e specificare 
l'orario a cui i laser devono essere accesi durante la 
settimana o nei fine settimana. 

Turn OFF daily Selezionare Yes e specificare l'orario a cui i laser devono 
essere spenti durante la settimana o nei fine settimana. 

Turn OFF when idle Selezionare Yes e specificare un intervallo di tempo di 
inattività dello scanner oltre il quale lo scanner spegnerà i 
laser. Se si seleziona No, lo scanner non si spegnerà in 
presenza di questa condizione.

3 Fare clic su OK.

Spegnimento o accensione manuale dei laser
1 Aprire la pagina delle proprietà Laser Auto ON/OFF Settings.

2 Fare clic su Turn Lasers on Now o Turn Lasers off Now.

3 Fare clic su OK.

NOTA Se si seleziona NO, i laser devono essere accesi e spenti manualmente, 
come descritto nella sezione seguente.
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Strumenti aggiuntivi

I seguenti strumenti aggiuntivi sono disponibili nel menu Tools.

Unlock Door
Lo strumento per l'apertura dello sportello (Tools > Unlock 
Door) può essere utilizzato per sbloccare manualmente lo 
sportello nel caso in cui il blocco dello sportello non funzioni 
correttamente. Questo può accadere, ad esempio, se il 
coperchio viene sollevato mentre il blocco funziona 
automaticamente alla fine di un ciclo del caricatore circolare.

Reset Calibration Warnings
Durante il normale funzionamento, lo scanner G2505C calibra i 
valori di PMT prima di ogni scansione, e calibra i laser durante 
l'inizializzazione del sistema e dopo ogni ciclo del caricatore 
circolare. Se la calibrazione non avviene correttamente, o se la 
calibrazione differisce significativamente dalla calibrazione 
precedente, il software dello scanner registra questo fatto e 
genera un messaggio di avvertenza nel Carousel Run Log.

L'avvertenza relativa alla calibrazione del valore PMT viene 
impostata quando il voltaggio PMT cambia di oltre il 20% 
rispetto al valore della precedente calibrazione.

I messaggi di avvertenza relativi alla calibrazione del laser 
vengono impostati quando i laser non riescono a raggiungere la 
potenza specificata durante il periodo di riscaldamento. In 
questo caso, il sistema imposta il messaggio di avvertenza e 
ricalibra i laser all'80% della loro potenza specificata. Il 
programma Scan Control scala il file TIFF per compensare la 
potenza inferiore dei laser.

È possibile reimpostare questi messaggi di avvertenza 
selezionando Tools > Reset Calibration Warnings.

Se anche la calibrazione successiva non va a buon fine e vengono 
nuovamente visualizzati i messaggi di avvertenza, è necessario 
contattare il centro vendita e assistenza Agilent locale.
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Extended Laser Calibration 

Extended Laser Calibration
La normale calibrazione dei laser non misura l'output di 
potenza massima. Il tool per la calibrazione estesa del laser 
effettua un controllo più approfondito del sottosistema dei 
laser. Se vengono visualizzati ripetuti messaggi di avvertenza 
relativi alla calibrazione del laser, l'assistenza Agilent può 
richiedere l'utilizzo del tool di calibrazione estesa del laser e 
l'invio di una e-mail contenente i file di log con i risultati.
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Manutenzione del sistema

La dovuta attenzione e la corretta manutenzione assicurano un 
funzionamento dello scanner per microarray senza problemi. In 
caso di dubbi sull’impiego o la manutenzione dello scanner per 
microarray, consultare il centro vendita e assistenza Agilent locale. 

Operazioni di 
manutenzione 
programmate

Questa sezione descrive le operazioni di manutenzione del 
software e dell’hardware che devono essere eseguite su base 
regolare per garantire un funzionamento efficiente dello 
scanner per microarray. 

Consigli per 
evitare 

problemi

Questa sezione fornisce alcuni consigli sull’impiego e la 
manutenzione dello scanner per microarray, che possono 
risultare utili per evitare problemi.

Manutenzione programmata del software
Eseguire le seguenti operazioni per mantenere inalterate le 
prestazioni della stazione di lavoro e del sistema operativo MS 
Windows:

• Almeno una volta alla settimana, controllare lo spazio su 
disco e archiviare i dati secondo la necessità.

• Una volta alla settimana eliminare i file temporanei  
(file *.mp, *.tmp) dalla cartella c:\Temp.

• Se si nota un rallentamento del sistema, deframmentare il 
disco fisso utilizzando il software di deframmentazione. 
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Manutenzione programmata dell’hardware

Eseguire le seguenti operazioni per mantenere inalterate le 
prestazioni dello scanner per microarray.

Controllo delle bocchette e del filtro dell’aria 

Un buon flusso di aria attraverso lo scanner per microarray è 
fondamentale per un funzionamento corretto. Bocchette 
ostruite e filtri dell’aria sporchi possono pregiudicare il corretto 
funzionamento dello scanner.

Bocchette Verificare tutte le bocchette settimanalmente per 
accertarsi che non siano ostruite da polvere, frammenti, mobili 
o altri strumenti.

Filtro dell’aria La pulizia del filtro dell’aria dello scanner per 
microarray deve essere verificata una volta al mese tramite la 
procedura seguente:

1 Spegnere lo scanner per microarray.

2 Aprire e rimuovere lo sportello di accesso al filtro dell’aria, 
situato sul lato destro dello scanner per microarray.

Figura 34 Apertura e rimozione dello sportello di accesso al filtro 
dell’aria

3 Rimuovere il filtro dell’aria dall’alloggiamento ed effettuare 
un controllo visivo.

Sportello 
rimovibile per 
l’accesso al 
filtro dell’aria.
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Figura 35 Rimozione del filtro dell’aria

Pulizia del filtro dell’aria

In caso di accumulo di eccessiva sporcizia o se il filtro dell’aria 
non viene pulito da oltre sei mesi, procedere alla pulizia.

1 Lavare il filtro dell’aria in acqua calda.

2 Strizzare accuratamente il filtro dell’acqua. 

Tutta l’acqua in eccesso deve fuoriuscire dal filtro dell’aria. 

3 Lasciar asciugare completamente il filtro dell’aria prima di 
reinstallarlo. È possibile utilizzare salviettine di carta per 
assorbire l’acqua in eccesso.

4 Reinstallare il filtro dell’aria nel relativo alloggiamento e 
richiudere lo sportello.

Verificare che il filtro dell’aria sia stato reinstallato una volta 
asciutto. La mancata reinstallazione del filtro dell’aria può 
causare l’accumulo di polvere all’interno dello strumento e 
questo potrebbe pregiudicare il corretto funzionamento dello 
scanner. 

I filtri dell’aria (p/n 3150-0956) possono essere ordinati 
direttamente presso il centro vendita e assistenza Agilent 
locale.

Sportello 
d’accesso al 
filtro dell’aria

Filtro 
dell’aria
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Consigli per evitare problemi

Eseguire le operazioni di manutenzione programmate descritte 
alle pagine precedenti e seguire questi consigli per mantenere 
inalterate le prestazioni dello scanner per microarray.

Consigli per evitare la perdita dei dati

• Evitare di caricare programmi che implicano un carico di 
lavoro eccessivo della CPU, perché questo potrebbe 
compromettere l’acquisizione dei dati durante la scansione.

Consigli per evitare danni ambientali allo scanner

• Tenere lo scanner per microarray lontano da liquidi e vapori.

• Ridurre al minimo e tenere sotto controllo le fluttuazioni di 
temperatura.

Evitare di esporre lo scanner per microarray alla luce diretta 
del sole. Evitare di posizionare lo scanner per microarray in 
prossimità di finestre, per quanto dotate di tapparelle o 
tende. Il calore del sole può scaldare l’alloggiamento dello 
scanner per microarray in modo non uniforme, causando 
problemi all’allineamento del sistema ottico.

Eseguire la scansione solo quando la temperatura del 
laboratorio è compatibile con le specifiche sulla temperatura 
di funzionamento dello scanner per microarray. Per garantire 
ottime prestazioni dello scanner per microarray, azionare lo 
scanner rispettando gli intervalli di temperatura specificati. 
(Vedere “Specifiche dello scanner per microarray” a 
pagina 96.)

• Controllo dell’umidità.

Lo scanner per microarray è potenzialmente sensibile alle 
condizioni di umidità con generazione di condensa. Per 
garantire ottime prestazioni dello scanner per microarray, 
azionare lo scanner rispettando gli intervalli di umidità 
specificati. (Vedere “Specifiche dello scanner per 
microarray” a pagina 96.) Consentire sempre 10 ore di 
equilibrazione termica prima di togliere lo scanner 
dall’imballo dopo la consegna.
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Consigli per mantenere inalterate le prestazioni dell’hardware

• Evitare di spostare lo scanner per microarray.

Lo spostamento dello scanner per microarray può causare 
una compromissione delle prestazioni. Contattare il centro 
vendita e assistenza Agilent locale per le istruzioni su come 
spostare lo scanner per microarray.

• Posizionare lo scanner per microarray su un tavolo di 
laboratorio o su un piano robusto.

• Evitare di appoggiarsi allo scanner per microarray.

• Per estendere la durata dei laser, impostare l'accensione e lo 
spegnimento automatico dei laser. Vedere “Impostazione 
dell'ora per accendere e spegnere i laser” a pagina 63 al 
Capitolo 4.

• Dopo l’accensione, prevedere il tempo necessario allo 
strumento per il riscaldamento e la stabilizzazione. Il tempo 
massimo di riscaldamento è di 30 minuti. 

• Mantenere pulito il pavimento del caricatore utilizzando un 
panno ed evitando l’impiego di solventi.

• Evitare l’uso di acetone o di altri solventi per la pulizia.

• Evitare di toccare gli ingranaggi nell’area del caricatore.

AV V E R T E N Z A Evitare di rimuovere le coperture. Non tentare di riparare o accedere 
ai componenti interni. Esiste il rischio di esporsi ad alta tensione e a 
radiazioni laser pericolose.
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Risoluzione dei problemi del sistema

Lo scanner per microarray Agilent è stato concepito per  
richiedere una manutenzione ridotta ed essere intuitivo. 
Qualora non si riesca a risolvere un problema riguardante il 
sistema, leggere questo capitolo di prima chiamare il centro 
vendite e assistenza di Agilent.

Assistenza tecnica Questa sezione fornisce informazioni importanti sull'assistenza 
tecnica. 

Domande 
frequenti

Questa sezione contiene soluzioni alle domande frequenti 
correlate all'assistenza e alla manutenzione. 

Risoluzione dei 
problemi legati 

all’hardware

Questa sezione descrive gli indicatori luminosi e spiega come 
sostituire i fusibili. 

Risoluzione dei 
problemi legati 

al software

Questa sezione illustra le precauzioni che occorre adottare 
quando si utilizza il Recovery CD per recuperare il software e i 
dati sul disco fisso.

Messaggi di 
errore dello 

scanner

Leggere questa sezione per informazioni sui principali messaggi 
di errore e le relative soluzioni.
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Assistenza tecnica
Per lo scanner per microarray Agilent è previsto un servizio di 
assistenza tecnica. Si raccomanda di leggere il resto del capitolo 
prima di chiamare il centro vendite e assistenza Agilent locale. 

Utilizzare Internet per contattare l'asistenza tecnica

Il software viene consegnato con URL predefinito che consente 
il collegamento all’assistenza tecnica Agilent per lo scanner per 
microarray. 

• Fare clic su Help > Technical Support.

Assistenza per la stazione di lavoro

In caso di problemi con la stazione di lavoro, leggere la 
documentazione fornita insieme al PC. 

Se il problema persiste, contattare il centro vendite e assistenza 
Agilent locale oppure fare clic su Help > Technical Support.

Assistenza per gli scanner per microarray

Qualora un problema riguardante lo scanner per microarray 
richieda l'assistenza del centro vendite e assistenza Agilent 
locale, è possibile che venga chiesto di fornire gli ultimi file di 
log diagnostici creati dal programma Scan Control. Questi file si 
trovano nella cartella C:\Programmi\Agilent\Microarray\Logs. 

Ulteriori informazioni di diagnostica, compresi i risultati 
dell’autotest di accensione (Power-on Self Test), possono essere 
catturati utilizzando il programma HyperTerminal. Per maggiori 
informazioni su come configurare e utilizzare questo protocollo 
di comunicazione, vedere “Utilizzo di HyperTerminal per 
acquisire dati diagnostici” a pagina 83.

Ogni scanner per microarray Agilent è identificato da un 
numero di serie univoco di 10 caratteri. Il numero di serie si 
trova su un’etichetta in due punti sullo scanner per microarray: 
una nello scomparto del caricatore circolare e una dietro la 
porta del filtro.
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Nella corrispondenza indirizzata al centro vendite e assistenza 
Agilent locale relativamente allo scanner per microarray, non 
dimenticare di includere il numero del modello e il numero di 
serie costituito da 10 caratteri. 

Prendere nota del numero di serie del proprio scanner per 
microarray Agilent, annotare il numero di versione del software 
e la data di installazione negli spazi sottostanti (se si stampa 
questa pagina) oppure trascriverli su un foglio di carta da 
conservare vicino allo scanner.

Informazioni sullo scanner

N. modello: 

N. di serie: 

Data di installazione: 

Versione software: 

N. versione di aggiornamento software/Data: 

N. versione di aggiornamento software/Data: 

Ricerca delle informazioni sulla versione per il software dello 
scanner 

1 Selezionare Help > About dalla barra del menu per trovare le 
informazioni sulla versione.

2 Per chiudere il programma, fare clic su OK.
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Domande frequenti (FAQ)

Quelle che seguono sono le domande frequenti (FAQ) con le 
relative risposte, utili per utilizzare e mantenere lo scanner per 
microarray Agilent nonché per risolvere gli eventuali problemi 
che potrebbero insorgere.

Tabella 2 FAQ 

FAQ Risposta

Desidero spostare lo scanner per 
microarray in un’altra area.

Gli spostamenti possono influenzare negativamente le prestazioni dello scanner. 
Rivolgersi al centro vendite e assistenza Agilent locale per ottenere aiuto nello 
spostamento dello scanner e assicurarsi un funzionamento corretto a 
spostamento avvenuto.

Posso salvare i file sulla rete durante la 
scansione?

Durante la scansione, Agilent consiglia di salvare i file di dati direttamente sul 
disco fisso locale. I file di dati possono essere salvati anche in una directory in 
rete. Se si verifica un problema di accesso di rete durante la scansione, i dati 
verranno salvati in una directory locale temporanea e verrà incluso un 
messaggio di avvertenza nel report del ciclo del caricatore circolare.

Dove è possibile reperire informazioni di 
supporto come driver, guide e soluzioni ai 
problemi per la propria stazione di lavoro?

In caso di problemi con la stazione di lavoro, leggere la documentazione fornita 
insieme al PC. Se il problema persiste, contattare il centro vendite e assistenza 
Agilent locale.

Non riesco ad aprire il coperchio per 
accedere al caricatore circolare.

Non forzare il coperchio, altrimenti si rischia di danneggiare lo scanner per microarray. 

1 Premere verso il basso per ridurre una eventuale tensione di spinta e quindi 
provare ad aprire il coperchio. In caso di mancato successo, passare al punto 2.

2 Chiudere e quindi riavviare il programma Scan Control.
3 Provare ad aprire il coperchio.
4 Se il coperchio non si apre, chiudere il programma Scan Control e spegnere lo 

scanner per microarray, quindi riaccenderlo. 
5 Provare ad aprire il coperchio.
6 Se il coperchio non si apre, contattare il centro vendite e assistenza Agilent locale.

Il programma Scan Control non risponde. Il programma Scan Control ha cessato di rispondere—non vi sono state 
variazioni nel messaggio di stato per oltre 15 minuti e non si riesce a chiudere il 
programma. Eseguire quanto segue:

1 aprire Windows Task Manager (Ctrl-Alt-Canc) e chiudere il programma Scan 
Control. Quindi riavviare il programma Scan Control.

2 Se il passo precedente fallisce, riavviare la stazione di lavoro, spegnere lo 
scanner per microarray e quindi riaccenderlo, attendere che l’indicatore di 
stato si spegna e quindi riavviare il programma Scan Control.
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Cosa faccio se un vetrino viene inserito 
solo per metà nel caricatore circolare dal 
braccio di caricamento automatico?

1 Spingere o tirare con delicatezza il braccio di caricamento automatico, a 
procedendo nella direzione che oppone meno resistenza, fino al termine del 
raggio di movimento. Non forzare.

2 Chiudere e quindi riavviare il programma Scan Control.
3 Se il problema persiste, chiamare il centro vendite e assistenza Agilent locale.

Lo scanner per microarray è acceso, ma la 
luce gialla non si spegne dopo 20 minuti.

1 Verificare che la stazione di lavoro sia accesa.
2 Verificare che il cavo USB sia collegato dalla stazione di lavoro allo scanner 

per microarray.
3 Contattare il centro vendite e assistenza Agilent locale.

Lo scanner per microarray scanner è 
acceso e il programma Scan Control è 
aperto, ma lo scanner non avvia la 
scansione.

1 Chiudere e quindi riavviare il programma Scan Control.
Lo scanner per microarray deve essere acceso prima di avviare il programma 
Scan Control. Se il programma Scan Control è stato avviato prima, la 
connessione non avviene quando si accende lo scanner.

2 Contattare il centro vendite e assistenza Agilent locale.

Tabella 2 FAQ (continua)

FAQ Risposta
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Risoluzione dei problemi legati all’hardware

Lo scanner per microarray include pochissimi componenti che 
possono essere sottoposti a manutenzione direttamente 
dall’utente. L’utente può adottare misure in base agli errori 
segnalati dagli indicatori luminosi di stato sul lato anteriore. 
Inoltre può sostituire i fusibili che proteggono il sistema. 
Qualsiasi altro problema, compresi gli inceppamenti, deve essere 
risolto contattando il centro vendite e assistenza Agilent locale.

In caso di problemi con la stazione di lavoro, vedere “Assistenza 
per la stazione di lavoro” a pagina 74.

Risoluzione dei problemi con gli indicatori luminosi di stato

Il pannello anteriore include tre indicatori luminosi di stato che 
indicano lo stato corrente dello scanner per microarray. 

Figura 36 Posizione degli indicatori luminosi di stato

La Tabella 3 descrive le azioni che devono essere adottate sulla 
base degli indicatori luminosi.

Indicatori 
luminosi di 
stato
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Tabella 3 Stato degli indicatori luminosi 

Stato dei LED Possibili 
cause

Azione 
suggerita

Verde Giallo Rosso

Spento Spento Spento Allo scanner non giunge 
corrente.

Verificare quanto segue:

• che l’interruttore di 
alimentazione sia attivato

• che il cavo di alimentazione sia 
connesso e che alla fonte vi sia 
corrente

• che i fusibili non siano saltati

Lampeggia una volta Lampeggia 
una volta

Lampeggia 
una volta

Test dei LED all’accensione 
(durata < 1 sec.)

Non occorre intervenire.

Lampeggiante Lampeggiante Spento È in corso l’autotest 
all’accensione 

Non occorre intervenire. Utilizzare 
HyperTerminal per acquisire 
informazioni diagnostiche. Vedere 
“Utilizzo di HyperTerminal per 
acquisire dati diagnostici” a 
pagina 83.

Spento Lampeggiante 

(20 sec. 
spento/ 20 
sec. acceso)

Spento Tentativo di connessione al 
PC in corso

Installare il software Scan Control 
8.0 qualora questo non fosse già 
installato.

Spento oppure 
Acceso

Lampeggiante 
(periodo = 1,3 
o 1,0 sec.)

Spento Download del firmware e 
inizializzazione DSP in corso

Non occorre intervenire.

Acceso Acceso Spento I laser si stanno riscaldando 
e non sono pronti per la 
scansione.

Attendere. Il tempo massimo di 
riscaldamento è di 30 minuti. 

Acceso Spento Spento Lo strumento è pronto per 
eseguire la scansione.

Non occorre intervenire.

Lampeggiante Spento Spento Scansione in corso. Non occorre intervenire.

Qualsiasi condizione Qualsiasi 
condizione

Acceso È stato rilevato un errore. Contattare il centro vendite e 
assistenza Agilent locale.
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Verifica e sostituzione dei fusibili dello scanner

Lo scanner per microarry ha tre fusibili, due per l’alimentazione 
elettrica e uno per il laser a luce rossa. I fusibili si trovano sul lato 
posteriore dello scanner per microarray. I fusibili 
dell’alimentazione elettrica si trovano direttamente sopra il cavo 
di alimentazione. Il fusibile del laser è inserito in un portafusibili 
circolare sulla sinistra della presa del cavo di alimentazione.

I fusibili possono essere ordinati direttamente da Agilent 
Technologies.

Controllo e sostituzione dei fusibili dell’alimentazione Se lo 
scanner per microarray non si accende benché la fonte di 
alimentazione sia risultata attiva al controllo, controllare e se 
necessario sostituire i fusibili. L’operazione viene eseguita sul 
retro dell’unità. 

1 Staccare il cavo di alimentazione.

2 Facendo leva con un piccolo cacciavite piatto, sollevare la 
linguetta di plastica sul bordo inferiore del portafusibili fino 
a farlo scattare.

3 Estrarre il portafusibili e verificare l’integrità del fusibile.

4 Se un fusibile è saltato, sostituirlo con un fusibile di classe 
T4A, 250 V CA (codice prodotto 2110-1309).

5 Reinserire il portafusibili nell’alloggiamento spingendo fino 
allo scatto.

6 Inserire il cavo di alimentazione.

AV V E R T E N Z A Disconnettere sempre il cavo di alimentazione prima di controllare o 
sostituire i fusibili. 

AT T E N Z I O N E Sostituire i fusibili solo con fusibili uguali o di classe equivalente. In 
caso di dubbio su quali fusibili utilizzare, contattare il centro vendite e 
assistenza Agilent locale prima di eseguire l'installazione.
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Figura 37 Estrazione del portafusibili per l’alimentatore

Controllo e sostituzione del fusibile per laser a luce rossa Se lo 
scanner per microarray si accende ma il laser a luce rossa non 
funziona, è possibile controllare e sostituire senza difficoltà il 
fusibile del laser operando dal retro dell'unità. 

1 Staccare il cavo di alimentazione.

2 Utilizzare un piccolo cacciavite piatto per svitare il cappuccio 
circolare in plastica fino a staccarlo. 

Portafusibili per 
l’alimentatore
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Figura 38 Portafusibili del laser

3 Estrarre il portafusibili e verificare l’integrità del fusibile.

4 Se un fusibile è saltato, sostituirlo con un fusibile di classe 
T500mA, 250 V CA (codice prodotto 2110-0458).

5 Riposizionare il portafusibili e avvitare il cappuccio.

Risoluzione dei problemi del braccio di caricamento automatico 
esteso nel caricatore

1 Spegnere lo scanner.

2 Ruotare il caricatore e spingere il braccio fino a riportarlo in 
posizione.

Se questo non funziona, contattare il centro vendita e 
assistenza Agilent locale per le istruzioni da seguire.

Portafusibili del 
laser

AT T E N Z I O N E Tentare di rimuovere il caricatore quando il braccio di caricamento 
automatico dei portavetrini è esteso nel caricatore può causare seri 
danni allo scanner per microarray. 
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Utilizzo di HyperTerminal per acquisire dati diagnostici

Il personale di assistenza Agilent e gli utenti possono acquisire 
informazioni per la risoluzione dei problemi dello scanner 
impostando una sessione HyperTerminal. Queste istruzioni si 
applicano ai sistemi Windows XP.

Impostazione di HyperTerminal

1 Accendere lo scanner per avviare l'inizializzazione.

2 Avviare il programma Scan Control per accendere i laser.

3 Assicurarsi che lo scanner sia acceso da almeno 30 secondi 
prima di avviare HyperTerminal (punto 4).

4 Fare clic su Start > Programmi > Accessori > 
Comunicazioni > HyperTerminal.

5 Nella finestra di dialogo Descrizione della connessione:

a Digitare Scanner nella casella di testo Nome.

b Fare clic su OK.

AT T E N Z I O N E Se lo scanner è acceso e HyperTerminal è in esecuzione, lo scanner 
non può effettuare le procedure di inizializzazione. Attendere almeno 
30 secondi dopo aver acceso lo scanner, HyperTerminal deve essere 
avviato almeno 30 secondi dopo l'accensione dello scanner.
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6 Nella finestra di dialogo Connect T:

a Dal menu a discesa Connect using, selezionare il numero 
COMX più elevato.

In genere si tratta di COM3, ma è possibile verificare 
mediante Windows Device Manager. La porta COM dello 
scanner è elencata come “USB Serial Port (COMX)”.

b Fare clic su OK.

7 Dalla finestra di dialogo COMX Properties:

a Selezionare 19200 come Bits per second.

b Selezionare None come Flow Control.
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c Fare clic su OK.

Viene visualizzata la finestra Scanner - HyperTerminal.

8 Fare clic su File > Save per salvare il file su Scanner.ht e 
chiudere la finestra.

9 Fare clic su Yes alla domande se si desidera interrompere la 
connessione.

10 Creare un'icona Scanner.ht di selezione rapida sul desktop:

a Fare clic su Start > Programs > Accessories > 
Communications.

b Dal sottomenu HyperTerminal, fare clic con il pulsante 
destro del mouse su Scanner.ht.

Si noti che il sottomenu HyperTerminal è stato aggiunto in 
fondo al menu Comunicazioni. Non fare clic con il pulsante 
destro del mouse sull’icona del programma HyperTerminal 
vicina alla parte superiore del menu.

c Dal menu di scelta rapida, fare clic su Create Shortcut.

d Fare clic e trascinare Shortcut to Scanner.ht sul desktop.
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11 Avviare la sessione di cattura testo con HyperTerminal:

a Fare doppio clic sull’icona Scanner.ht sul desktop.

b Fare clic su Transfer > Capture Text.

c Fare clic su Browse.

d Nella finestra di dialogo Select Capture File, trovare 
l’unità Archive (E:).

e Creare una nuova cartella chiamata Support.

f Nella cartella Support, creare una nuova cartella e 
chiamarla HyperTerminal Capture Files.

g Nella cartella HyperTerminal Capture Files, digitare il 
nome del file Captureaammgg-n. nella casella di testo File, 
dove aammgg rappresenta la data odierna e n.rappresenta il 
numero della sessione di cattura della giornata.

h Fare clic su Save.

i Fare clic su Start nella finestra di dialogo Capture Text.

I dati HyperTerminal verranno aggiunti al file finché 
HyperTerminal verrà chiuso o finché la sessione Capture 
Text… verrà arrestata dal menu a discesa Transfer.

HyperTerminal si chiuderà alla disconnessione.

Avviare una sessione di cattura HyperTerminal dopo la 
configurazione iniziale

Se i laser hanno effettuato la procedura di riscaldamento, 
passare al punto 3.

1 Accendere lo scanner per avviare l'inizializzazione.

2 Avviare il programma Scan Control per avviare il 
riscaldamento dei laser.
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3 Fare doppio clic sull’icona Scanner.ht sul desktop.

4 Dal menu a discesa Transfer di HyperTerminal, fare clic su 
Capture Text.

5 Nella finestra di dialogo Capture Text, 

a Modificare il nome del file nella casella di testo File in 
modo da riflettere la data e la sessione di cattura odierna.

b Fare clic su Avvio.

È anche possibile fare clic su Browse per aprire la finestra di 
dialogo Select Capture File. Dalla casella di testo Select 
Capture File scegliere una nuova cartella o un nuovo nome 
file, altrimenti la sessione di acquisizione originale verrà 
sovrascritta. Al termine fare clic su Save per continuare.

Risoluzione dei problemi legati al software
Nel caso il computer si rompa o si desideri ricaricare l'immagine 
del disco fisso fornita da Agilent con il PC, Agilent fornisce un CD 
di recupero che consente di riattribuire l’immagine al disco fisso. 

Per utilizzare il CD è necessario, prima di utilizzarlo, 
disconnettere il cavo USB collegato al retro del PC.

AT T E N Z I O N E Se questo cavo non viene disconnesso, è possibile che le impostazioni 
predefinite di Agilent per questi dispositivi USB vengano modificate e 
che il software non riconosca lo scanner quando viene riavviato.
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Messaggi di errore dello scanner per microarray

Questa sezione spiega come usare i messaggi di errore che si 
possono incontrare.

Sorgenti dei messaggi di errore

Il monitor del computer visualizza messaggi di errore per 
l'hardware dello scanner per microarray, il software Scan 
Control e Feature Extraction, Microsoft Windows e la stazione 
di lavoro. Leggere la barra del titolo del messaggio di errore per 
determinare la sorgente del messaggio di errore.

Figura 39 Barra del titolo di un messaggio di errore di Scan Control 

Questo argomento presenta messaggi di errore per l’hardware 
dello scanner per microarray e il programma Scan Control.

Se la barra del titolo indica che vi sono problemi con la stazione 
di lavoro o Windows, consultare “Assistenza per la stazione di 
lavoro” a pagina 74 per informazioni.

Dove possono apparire messaggi di errore relativi allo scanner

I messaggi di errore possono apparire nei seguenti luoghi:

• Gli errori che si verificano durante l’inizializzazione dello 
scanner per microarray compaiono nel messaggio Scanner 
status nella finestra Scan Control. Vedere “Operazione 4. 
Scansione dei vetrini” a pagina 32 al Capitolo 2.

• Gli errori che si verificano prima dell’avvio della scansione 
vengono visualizzati in finestre di messaggio.

La barra del titolo del messaggio di errore indica che questo 
messaggio è correlato all’hardware del caricatore circolare.
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• Alcuni errori durante la scansione vengono visualizzati nel 
messaggio Status nella finestra di dialogo Scan Progress.

• I messaggi di errore vengono registrati nel log di report del 
caricatore circolare mano a mano che il ciclo del caricatore 
prosegue. Vedere “Visualizzazione del Carousel Report Log 
durante il ciclo” a pagina 41 al Capitolo 2. 

Si raccomanda di consultare il log di report almeno dopo la 
prima scansione e quando il ciclo del caricatore è giunto al 
termine. Il report viene generato automaticamente alla fine 
di un ciclo del caricatore.

Risoluzione dei problemi con i messaggi di errore

Lo scanner per microarray Agilent genera messaggi di errore 
per aiutare a risolvere i problemi che potrebbero insorgere. 
Molti dei messaggi di errore includono una soluzione nella 
casella di testo; seguire le istruzioni.

La tabella che segue presenta alcuni dei messaggi di errore privi 
di istruzioni. Queste descrizioni contengono informazioni che 
possono essere utili per risolvere i problemi.

Tabella 4 Messaggi di errore  

Messaggio di errore Descrizione o soluzione

Application Is Already Running 
(L’applicazione è già in esecuzione).

Non è possibile eseguire due copie del programma Scan control 
contemporaneamente.

Autofocus error (Errore dell’Autofocus): 
Did not detect two reflective surfaces 
during home (Impossibile rilevare due 
superfici riflettenti nella posizione iniziale).

Eseguire quanto segue:

1 Verificare che il vetrino sia inserito correttamente nel portavetrini. Vedere 
“Operazione 2. Inserire i vetrini nei portavetrini” a pagina 24, oppure provare 
un altro portavetrini.

2 Verificare che il vetrino risponda alle specifiche di Agilent. Vedere “Specifiche 
dei vetrini” a pagina 98. 

3 Se il problema persiste con un vetrino, è possibile che quel vetrino presenti 
dei problemi.

4 Se necessario, selezionare una regione di scansione appropriata. Per alcuni 
vetrini non Agilent con bordi traslucidi o opachi, la regione di scansione 
selezionata può essere troppo vicina alle aree non trasparenti del vetro. 
Vedere “Creazione di una nuova regione di scansione con Scan Region 
Editor” a pagina 60.

5 Contattare il centro vendite e assistenza Agilent locale. 
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Autofocus error (Errore dell’Autofocus). 
No PSD signal is detected (Non è stato 
rilevato alcun segnale PSD). Make sure 
there is a slide in the chip holder 
(Assicurarsi che nel portavetrini vi sia un 
vetrino).

Eseguire quanto segue:

1 Verificare che il vetrino sia inserito correttamente nel portavetrini. Vedere 
“Operazione 2. Inserire i vetrini nei portavetrini” a pagina 24.

2 Verificare che il vetrino risponda alle specifiche di Agilent. Vedere “Specifiche 
dei vetrini” a pagina 98. 

3 Se il problema persiste con un vetrino, è possibile che quel vetrino presenti 
dei problemi. 

4 Per alcuni vetrini non Agilent con bordi traslucidi o opachi, la regione di 
scansione selezionata può essere troppo vicina alle aree non trasparenti del 
vetro. Vedere “Creazione di una nuova regione di scansione con Scan Region 
Editor” a pagina 60.

5 Contattare il centro vendite e assistenza Agilent locale. 

Autofocus was unable to retain focus as 
it travelled to the scan start position 
(L’Autofocus non è riuscito a conservare 
il fuoco mentre si spostava alla posizione 
di inizio scansione).

Eseguire quanto segue:

1 Verificare che un codice a barre non abbia ostruito la posizione di inizio scansione.
2 Selezionare una regione di scansione più piccola.
3 Se il problema persiste con un vetrino, è possibile che quel vetrino presenti 

dei problemi. 
4 Contattare il centro vendite e assistenza Agilent locale. 

Cannot eject chip (Impossibile espellere il 
vetrino). There is already a chip in the slot 
(Esiste già un vetrino nello slot).

Eseguire quanto segue:

1 Aprire il coperchio dello scanner.
2 Rimuovere il portavetrini dallo slot iniziale. 

Cannot load chip, moving the arm may be 
unsafe (Impossibile caricare il vetrino, 
spostare il braccio potrebbe non essere 
sicuro).

Eseguire quanto segue:

1 Aprire il coperchio dello scanner.
2 Se il braccio del caricatore automatico è già parzialmente esteso nello scomparto 

del caricatore circolare, spostarlo con delicatezza nello scanner finché si arresta.
3 Se il problema persiste, chiamare il centro vendite e assistenza Agilent locale.

Command timed out (Time out comando). Eseguire quanto segue:

1 Verificare che il cavo USB dallo scanner per microarray alla stazione di lavoro 
sia connesso. 

2 Spegnere e riaccendere lo scanner per microarray.
3 Riavviare il programma Scan Control.
4 Se il problema persiste, chiamare il centro vendite e assistenza Agilent locale.

Tabella 4 Messaggi di errore  (continua)

Messaggio di errore Descrizione o soluzione
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Connection manager reports that there 
are no instruments (Il Connection 
Manager riferisce che non vi sono 
strumenti).

Tra le cause possibili per questo errore vi sono:

• Lo scanner per microarray potrebbe non essere acceso oppure lo scanner per 
microarray è stato acceso ma non è trascorso un tempo sufficiente affinché lo 
scanner per microarray abbia completato l’autotest e l’inizializzazione. 
Selezionare OK per chiudere il messaggio Scan Control, attendere alcuni 
minuti e  riprovare.

• Lo scanner per microarray potrebbe non essere connesso alla stazione di 
lavoro. Verificare che il connettore USB sia connesso allo scanner per 
microarray e alla stazione di lavoro. Se il connettore USB è disconnesso, 
riconnettere il cavo, riavviare il computer e, se necessario, spegnere e 
riaccendere lo scanner per microarray.

• Le proprietà di networking del protocollo Internet (TCP/IP) dello scanner 
potrebbero essere state alterate. Verificare che l'indirizzo IP della Local Area 
Connection dello scanner sia 10.0.0.1 e che la maschera di sottorete sia 
255.255.255.0.

• È possibile che il firewall di Windows XP impedisca la comunicazione. 
Disabilitare il firewall.

• Se la stazione di lavoro è stata riavviata, potrebbe essere necessario spegnere 
e riaccendere lo scanner per microarray dopo il riavvio di Windows.

Error ejecting chip (Errore nell’espulsione 
del vetrino). Il vetrino è stato espulso 
nello slot iniziale. 

Eseguire quanto segue:

1 Spegnere lo scanner.
2 Aprire il coperchio dello scanner.
3 Ruotare il caricatore circolare a mano fino a che lo slot iniziale non è bloccato 

dal braccio del caricatore automatico.
4 Rimuovere il coperchio dallo slot iniziale.
5 Riportare dolcemente il braccio del caricatore automatico nello scanner fino a 

che si arresta. 
6 Se il problema persiste, chiamare il centro vendite e assistenza Agilent locale.

Failed to communicate with connection 
manager (Impossibile comunicare con il 
Connection Manager).

Eseguire quanto segue:

1 Riavviare la stazione di lavoro.
2 Spegnere e riaccendere lo scanner per microarray.
3 Dopo parecchi minuti, avviare il programma Scan Control.

Lasers never became ready (I laser non 
diventano mai pronti).

Eseguire quanto segue:

1 Verificare che il numero visualizzato sul selettore di tensione sul retro dello 
scanner corrisponda alla tensione erogata.

2 Se la stazione di lavoro è stata riavviata, potrebbe essere necessario 
spegnere e riaccendere lo scanner per microarray dopo il riavvio di Windows.

3 Se il problema persiste, chiamare il centro vendite e assistenza Agilent locale.

Tabella 4 Messaggi di errore  (continua)

Messaggio di errore Descrizione o soluzione
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Missing or corrupt ChipRegions.ini file 
(File ChipRegions.ini assente o rovinato).

Eseguire quanto segue:

1 Se si dispone di una copia di back-up del file ChipRegions.ini, copiarla in C:\
Program Files\Agilent\Microarray. Il fatto di disporre di una copia del file 
ChipRegions.ini evita la perdita e la necessità di ricreare regioni di scansione 
personalizzate.

2 Se non si dispone di una copia di back-up, cercare il file ChipRegions.bak 
nella cartella e rinominarlo ChipRegions.ini.

3 Se manca anche questo file, reinstallare il programma Scan Control.
4 Contattare il centro vendite e assistenza Agilent locale.

Not enough disk space to create file (Non 
c’è spazio a sufficienza su disco per 
creare il file).

Il disco fisso non ha spazio a sufficienza per creare un file dove archiviare i dati di 
scansione. È possibile adottare una delle soluzioni seguenti:

• accedere al menu principale di Scan Control e impostare la directory di output 
su un’altra directory su un altro disco fisso.

• Cancellare o trasferire i file dal disco fisso corrente. Vedere “Operazione 5. 
Trasferimento dei file e archiviazione dei dati” a pagina 42.

PMT calibration may be unstable (La 
calibrazione PMT potrebbe essere 
instabile). Using last known PMT setting 
(Utilizzare l’ultima impostazione PMT nota).

È possibile reimpostare questo messaggio di errore utilizzando lo strumento 
Reset Calibration Warnings. Vedere “Strumenti aggiuntivi” a pagina 65. Se il 
messaggio persiste o si ripete, contattare il centro vendite e assistenza Agilent 
locale.

PMT calibration lost! (La calibrazione 
PMT è andata persa!) Using factory 
default settings (Vengono utilizzate le 
impostazioni predefinite di fabbrica).

È possibile reimpostare questo messaggio di errore utilizzando lo strumento 
Reset Calibration Warnings. Vedere “Strumenti aggiuntivi” a pagina 65. Se il 
messaggio persiste o si ripete, contattare il centro vendite e assistenza Agilent 
locale.

Slide skipped because it is outside the 
allowable thickness range or the selected 
scan region contains an obstruction to the 
initial focus positions (Il vetrino è stato 
saltato perché è al di fuori dell’intervallo di 
spessore ammesso oppure la regione di 
scansione selezionata contiene 
un’ostruzione alle posizioni di fuoco iniziali).

Eseguire quanto segue:

1 Verificare la presenza sul vetrino saltato di un codice a barre, di residui di 
ibridazione o di un’altra ostruzione non trasparente che possa interferire con 
la posizione di fuoco iniziale. La posizione di fuoco iniziale primaria si trova 1 - 
2 mm sulla sinistra della regione di scansione sulla riga più alto della regione 
di scansione.

2 Misurare lo spessore del vetro e verificare che soddisfi le specifiche in 
“Specifiche dei vetrini” a pagina 98.

The autoloader loading arm is in an 
unknown location (Il braccio di caricamento 
automatico si trova in una posizione 
sconosciuta). It is unclear if it is safe to 
move the carousel (Non è chiaro se è sicuro 
muovere il caricatore circolare).

Eseguire quanto segue:

1 Aprire il coperchio dello scanner.
2 Se il braccio del caricatore automatico è già parzialmente esteso nello scomparto 

del caricatore circolare, spostarlo con delicatezza nello scanner finché si arresta.
3 Chiudere e quindi riavviare il programma Scan Control.
4 Se il problema persiste, chiamare il centro vendite e assistenza Agilent locale.

Tabella 4 Messaggi di errore  (continua)

Messaggio di errore Descrizione o soluzione
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The chip carousel is not present (Il caricatore 
circolare di vetrini non è presente). Please 
place the carousel in the scanner and try 
again (Riposizionare il caricatore circolare 
nello scanner e riprovare).

Inserire il caricatore circolare nello scanner per microarray e riavviare il ciclo del 
caricatore. Vedere “Operazione 2. Inserire i vetrini nei portavetrini” a pagina 24.

The carousel may be misaligned (Il 
caricatore circolare potrebbe essere 
disallineato). Please remove the carousel, 
make sure that its opening is aligned with 
home position and reinsert the carousel 
(Rimuovere il caricatore circolare, 
assicurarsi che l’apertura sia allineata con la 
posizione iniziale e reinserire il caricatore).

Vedere “Operazione 2. Inserire i vetrini nei portavetrini” a pagina 24.

The slide failed to eject (Il vetrino non è 
stato espulso). Pressing OK will 
re-initialize the instrument (Premere OK 
per inizializzare nuovamente lo 
strumento).

Quando si preme OK, lo scanner per microarray ripete l’inizializzazione. Se 
questa non riesce, eseguire quanto segue:

1 Aprire il coperchio dello scanner.
2 Se il braccio del caricatore automatico è già parzialmente esteso nello 

scomparto del caricatore circolare, spostarlo con delicatezza nello scanner 
finché si arresta. Non forzarlo se non si muove agevolmente.

3 Chiudere e quindi riavviare il programma Scan Control.
4 Se il problema persiste, chiamare il centro vendite e assistenza Agilent locale.

The software has detected a serious 
sensor error that may have existed prior 
to the installation of this version of 
software (Il software ha rilevato un grave 
errore del sensore che è possibile 
esistesse prima dell’installazione di 
questa versione del software).

Contattare il centro vendite e assistenza Agilent locale.

Unable to lock instrument specified by 
connection manager (Impossibile 
bloccare lo strumento specificato dal 
Connection Manager).

Eseguire quanto segue:

1 Riavviare la stazione di lavoro.
2 Spegnere e riaccendere lo scanner per microarray.
3 Avviare il programma Scan Control.

Tabella 4 Messaggi di errore  (continua)

Messaggio di errore Descrizione o soluzione
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Se un messaggio di errore non compare nella tabella

Questa tabella non elenca tutti i possibili messaggi di errore. Nel 
caso compaia un messaggio di errore non elencato e non si 
riesca a risolvere il problema, comportarsi come segue:

1 Scrivere il messaggio di errore.

2 Riavviare il programma Scan Control.

3 Se il passaggio 2 non risolve il problema, comportarsi come segue:

a Riavviare la stazione di lavoro.

b Spegnere e riaccendere lo scanner per microarray.

c Riavviare il programma Scan Control.

4 Se il passaggio 3 non risolve il problema contattare il centro 
vendite e assistenza Agilent locale.

You must select a region to scan first 
(Prima selezionare una regione da 
scansire).

Per inserire una regione di scansione non specificata nel profilo selezionato 
nella tabella di scansione:

1 Selezionare lo slot o gli slot per i quali si desidera immettere la regione.
2 Fare clic sulla freccia verso il basso accanto alla selezione.
3 Selezionare una regione di scansione dalla lista delle regioni di scansione. Vedere 

“Modifica delle impostazioni individuali della tabella di scansione” a pagina 46. 
4 Avviare la scansione o il ciclo del caricatore circolare. 

You must select at least one dye channel 
(Occorre selezionare almeno un canale di 
colorazione).

1 Selezionare lo slot o gli slot di cui si desidera modificare il canale di colorazione.
2 Fare clic sulla freccia verso il basso accanto alla selezione.
3 Selezionare un'impostazione del canale di colorazione dalla lista. Vedere 

“Dye channel” a pagina 49.

You must close the door first (Prima 
chiudere la porta).

L’inizializzazione dello scanner per microarray e le operazioni di scansione non 
possono essere eseguite con il coperchio dello scanner per microarray aperto. 
Chiudere il coperchio.

Warning (Avvertenza): The laser power 
does not fall within expected thresholds 
(La potenza del laser non rientra nei limiti 
attesi). Please contact an Agilent 
representative (Contattare un 
rappresentante Agilent).

Attendere il necessario periodo di riscaldamento (circa 30 minuti) quando il 
messaggio di stato nel programma Scan Control visualizza Status Ready. È 
possibile reimpostare questo messaggio di errore utilizzando lo strumento Reset 
Calibration Warnings. Vedere “Strumenti aggiuntivi” a pagina 65. Se il messaggio 
persiste o si ripete, contattare il centro vendite e assistenza Agilent locale.

Il programma Scan Control scala il file TIFF per compensare la potenza inferiore dei laser.

Tabella 4 Messaggi di errore  (continua)

Messaggio di errore Descrizione o soluzione
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Questo capitolo include specifiche, informazioni normative e 
istruzioni per il controllo della tensione se si sposta lo strumento.

Specifiche dello scanner per 
microarray

Questa sezione descrive le specifiche dello scanner per 
microarray. Per le specifiche della stazione di lavoro, vedere la 
guida all’uso fornita con il PC. 

Specifiche dei vetrini Questa sezione presenta le specifiche per i vetri e il codice a 
barra che lo scanner può accettare.

Informazioni 
normative

Questa sezione riporta le normative sulle emissioni acustiche, il 
riciclaggio e lo smaltimento, l'interferenza elettromagnetica e la 
sicurezza a cui lo scanner per microarray è conforme.

Controllo della 
tensione di 

ingresso

In questa sezione è possibile assicurarsi che la tensione di 
ingresso è corretta dopo uno spostamento.
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Specifiche dello scanner per microarray

Lo scanner per microarray opera nel contesto delle seguenti 
specifiche: 

Dimensioni 
approssimative

Altezza: 97 cm; altezza con il coperchio chiuso, 55 cm

Larghezza: 91 cm 

Profondità: 71 cm 

Queste dimensioni si riferiscono all’altezza e alla larghezza 
massime quando le porte sono aperte e a uno spazio di 80 mm 
(3”) di profondità necessari per una ventilazione adeguata. 

Peso 99 Kg

Tensione in 
ingresso

100, 120, 220, o 240 V CA a 4 A

50/60 Hz

Fusibili Due fusibili per l’alimentazione: T4A, 250 V CA  
(codice prodotto 2110-1309)

Un fusibile per il laser: T500mA, 250 V CA  
(codice prodotto 2110-0458)

Intervallo di 
temperatura

In funzione: da 15° a 30°C

Conservazione: da -20° a +50°C

Umidità In funzione: 15% - 95% umidità relativa a 30°C

Potenzialmente sensibili a condizioni di umidità con generazione 
di condensa. Seguire le precauzioni indicate nel Capitolo 5.

Altitudine Massima in funzione: 2.300 m

Massima di conservazione: 4.600 m

Utilizzo Utilizzo in ambienti chiusi

Informazioni sul 
laser

Lunghezze d’onda di eccitazione: 

• laser SHG-YAG: 532 nm

• laser elio-neon (HeNe): 633 nm

Potenza: 20 mW a 532 nm e 23 mW a 633 nm, entrambi 
controllati a 13 mW
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Regione di 
scansione 
massima

Agilent G2565CA: 71 mm x 21,6 mm

regione dei 
stampa del 
microarray 

suggerita

1 mm più piccola della regione di scansione sulla destra, 2 mm 
sulla sinistra e 0,6 mm in alto e in basso. Per i vetrini non 
Agilent, la regione di stampa è più piccola di questa di una 
quantità uguale alla tolleranza di stampa dell’array.

Colorazioni 
ammesse

Cianina 3 (Cy-3) e cianina 5 (Cy-5) e colorazioni simili a Cy-3 e 
Cy-5 e colorazioni Alexa 647, 555, 660 

Risoluzione 
(dimensioni dei 

pixel)

2, 3, 5 o 10 micron

Errore di 
posizionamento 

pixel

< 1 pixel a una risoluzione di 5 micron

Uniformità non uniformità globale 5% CV, la non uniformità locale media è 
tipicamente pari a 1% su tratti di 100um.

Tempo di 
scansione

Intervallo dinamico Intervallo dinamico a 16 bit per singola scansione >104 

Intervallo dinamico a 20 bit per singola scansione >105

Intervallo dinamico esteso di scansione doppia (XDR) > 106

Tabella 5 Tempo di scansione per scansioni con passata singola e doppia 
per la regione di scansione Agilent HD 61 x 21,6 mm

Risoluzione Tempo di 
scansione, min.

Passata singola a 2 micron 20

Passata singola a 3 micron 15

Passata singola a 5 micron 8

Passata singola a 10 micron 8

Passata doppia a 2 micron 40

Passata doppia a 3 micron 30

Passata doppia a 5 micron 16
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Specifiche dei vetrini

Dimensioni di scansione
La regione di scansione è specificata nella Figura 40. Tutte le 
dimensioni sono in millimetri e il punto di riferimento è 
l’angolo in basso a destra del vetro. 

Figura 40 Regione di scansione per Agilent G2565CA

Specifiche del vetro
Lo scanner per microarray utilizza portavetrini per spostare i 
microarray dentro e fuori il caricatore circolare. Questi 
portavetrini sono concepiti per accogliere un pezzo di vetro 
nominale di 1” × 3”. 

Le specifiche dettagliate del vetro sono le seguenti:

• 1” di larghezza (25,4 mm, -0,45 mm o +0,7 mm)

• 3” di lunghezza (7,62 mm, +0,25 mm o -1,4 mm)

• 1 mm di spessore (+/-0,1 mm) 

• No vetrini specchiati

• Elevata qualità con fluorescenza intrinseca ridotta

• Indice di rifrazione da 1,510 a 1,515.
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Specifiche dei codici a barre e delle etichette con codice a barre

Specifiche dei codici a barre per i vetrini Agilent

Lo scanner G2565CA legge i codici a barre posizionati sul lato 
attivo dei vetrini. 

Per garantire la compatibilità retroattiva con gli scanner 
modello G2565AA, i microarray Agilent continuano ad avere i 
codici a barre su entrambi i lati. L'etichetta con il testo “Agilent” 
indica il lato attivo; l'etichetta con il valore numerico indica il 
lato inattivo.

Figura 41 Orientamento del codice a barre sul vetrino Agilent rispetto 
alla superficie del microarray

Specifiche dei codici a barre per i vetrini non Agilent

• Lo spessore massimo dell’etichetta del microarray è 0,2 mm. 
Assicurarsi che nell’etichetta non vi siano bolle. Non 
aggiungere etichette su etichette vecchie o sostituire le 
etichette che cominciano a staccarsi.

• Non collocare etichette con codici a barre su vetrini la cui 
regione di scansione supera i 61 mm. Inserire l’identificatore 
del vetrino o il codice a barre manualmente per i vetrini la 
cui regione di scansione supera i 61 mm.
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• Per un vetrino con codice a barre, la distanza tra il bordo 
della regione di scansione del microarray e il bordo del 
codice a barre non può essere inferiore a 4 mm.

Figura 42 Posizione del codice a barre su vetrini non Agilent

• La larghezza del codice a barre deve essere di circa 6 mm; la 
larghezza raccomandata del codice a barre è destinata a una 
regione di scansione di 61 mm. Etichette con codici a barre 
più larghe o più lunghe possono essere utilizzate riducendo 
proporzionalmente la regione di scansione.

• Le etichette con codici a barre devono essere sufficientemente 
stretti da non interferire con le linguette del portavetrini. 

• L’inclinazione massima ammessa nel posizionamento 
dell’etichetta con il codice a barre sul vetrino è di ±3°.

Il codice a barre deve soddisfare i seguenti requisiti: 

• La zona silenziosa minima (la regione tra il bordo 
dell’etichetta e l’inizio o la fine del codice a barre) è 10 volte 
la dimensione di X su ciascun lato del codice a barre. 

• Le linee del codice a barre devono essere parallele al bordo 
lungo del vetrino con una tolleranza di inclinazione di ±3°.

• Agilent supporta i seguenti formati di codice a barre:

• Code 128: i codici a barre non Agilent con 12 cifre non 
devono cominciare con 2

• CODABAR: massimo 8 cifre;  
spessore minimo della linea = 6 mil

>4 mm
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• Code 39: massimo 8 cifre;  
spessore minimo della linea = 6 mil

• Code 93: massimo 8 cifre;  
spessore minimo della linea = 6 mil

• L’altezza minima del codice a barre deve essere

• Code 128: 15% della lunghezza del codice a barre per il 
Codice 128

• Code 39, Code 93, CODABAR: 5 mm o 15% della lunghezza 
del codice a barre, a seconda di qual è il maggiore
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Informazioni normative

Questa sezione riporta le informazioni normative riguardanti lo 
scanner per microarray.

Destinato esclusivamente a scopi di  ricerca

Lo scanner per microarray Agilent G2565CA è destinato 
ESCLUSIVAMENTE A SCOPI DI RICERCA. 

Informazioni sulle emissioni acustiche

Dichiarazione del produttore

Inglese This statement is provided to comply with the requirements 
of the German Sound Emission Directive, from 18 January 
1991. Sound Pressure Lp < 70 dB(A), at operator’s position, 
normal operation, according to EN 27779 (Type Test).

Deutsch Die folgende Information wird in Übereinstimmung mit den 
Anforderungen der Maschinenlärminformationsverordnung vom 
18. Januar 1991 erteilt. Schalldruckpegel am Arbeisplatz bei 
normalem Betrieb, Lp < 70 dB(A), nach EN 27779 (Typprüfung).

Riciclo e smaltimento

Per maggiori informazioni sul 
riciclo e lo smaltimento, contattare 
Agilent Technologies.

Questa unità è concepita per il riciclo al termine della sua vita 
utile. Smaltire l’unità nel rispetto delle disposizioni locali. 

Interferenza elettromagnetica

Lo scanner è progettato per essere usato esclusivamente con 
cavi schermati.

Emissioni Rispetta i livelli di emissioni per le attrezzature di Classe A 
come stabilito dalla norma lEC 61326-1. Questa attrezzatura 
non è destinata all'uso in aree residenziali. 

Immunità Questo dispositivo è conforme ai livelli di immunità imposti 
dalla norma IEC 61326-1 per un ambiente non controllato, non 
industriale. Per i livelli specifici vedere l’allegata Dichiarazione 
di Conformità. 
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Canada Questo dispositivo ISM (Industriale-Scientifico-Medico) 
soddisfa la norma canadese ICES-001. 

Cet appareil ISM est conforme a la norme NMB-001 du Canada.

Informazioni sulla sicurezza

Questo scanner soddisfa i seguenti standard di sicurezza:

CAN/CSA N. C22.2  
N. 1010.1 - 92

Safety Requirements for Electrical 
Equipment for Measurement, Control, and 
Laboratory Use, Part 1: General Requirements 
(Incluso Emendamento 1)

CAN/CSA-C22.2  
N. 1010.1B-97 

Emendamento 2 alla norma CAN/CSA-C22.2 
N.1010.1-92, Safety Requirements for Electrical 
Equipment for Measurement, Control, and 
Laboratory Use,  
Part 1: General Requirements

UL Std N. 3101.1 Electrical Equipment for Laboratory Use:  
Part 1: General Requirements

UL Std N. 3111-1 Equipment for Measurement Use;  
Part I: General Requirements

ISA S82.01-1994 Safety Standards for Electrical and Electronic 
Test, Measuring, Controlling, and Related 
Equipment - General Requirements

IEC 61010-1 Safety Requirements for Electrical Equipment for 
Measurement, Control, and Laboratory Use,  
Part 1: General Requirements

IEC 825-1 Safety of laser products Part 1: Equipment 
classification, requirements and user's guide.

EN60825-1

(Incluso Emendamento 1:1992 ed Emendamento 2:1995)
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• Livello di inquinamento: 2

• Categoria di installazione: II

• Attrezzatura di Classe 1; richiede un sistema di messa a terra

• Prodotto laser di Classe 1 

• Prodotto approvato UL/CSA 
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Controllo della tensione di ingresso

Verifica della tensione di ingresso
Se si accende lo scanner per microarray per la prima volta o dopo 
averlo trasferito in un nuovo sito, è necessario dapprima 
verificare che la tensione di ingresso riportata sul retro 
dell’apparecchio sia impostata sul valore corretto. La tensione di 
ingresso può essere impostata su uno dei quattro valori seguenti:

• 100 V CA

• 120 V CA

• 220 V CA

• 240 V CA

1 Controllare il retro dello scanner per microarray. 

2 Verificare l’impostazione della tensione di ingresso 
attraverso la finestrella.

Figura 43 Finestrella per la verifica dell’impostazione della tensione di 
ingresso

3 Se l’impostazione della tensione di ingresso corrisponde alla 
tensione di rete, è possibile accendere lo scanner per 
microarray senza pericolo.

Se l’impostazione della tensione di ingresso non corrisponde 
alla tensione di rete, modificare le impostazioni di tensione.

Finestrella per la 
verifica 
dell’impostazione 
della tensione di 
ingresso
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Modifica dell’impostazione di tensione
1 Staccare il cavo di alimentazione.

2 Facendo leva con un piccolo cacciavite piatto, sollevare la 
linguetta di plastica sul bordo inferiore del portafusibili fino 
a farlo scattare.

Figura 44 Estrazione del portafusibili per l’alimentatore

3 Estrarre il portafusibili. 

AV V E R T E N Z A Staccare sempre il cavo di alimentazione prima di modificare 
l’impostazione della tensione di ingresso.

Portafusibili
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4 Utilizzare una pinza a becco fine per rimuovere il selettore di 
tensione.

Figura 45 Rimozione del selettore di tensione dal portafusibili

5 Inserire il selettore di tensione in modo che il numero visibile 
corrisponda alla tensione di rete.

6 Reinserire il portafusibili nell’alloggiamento spingendo fino 
allo scatto.

7 Inserire il cavo di alimentazione.

Portafusibili

Selettore di tensione
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Informazioni normative
emissioni acustiche, 102
interferenza elettromagnetica, 102
riciclo e smaltimento, 102

informazioni sulla versione, ricerca, 75
interruzione della scansione, 41
intervallo dinamico

16 bit o 20 bit, 50
file TIFF, 50

L
laser

accensione/spegnimento 
automatico, 63

accensione/spegnimento manuale, 64
controllo o sostituzione dei fusibili, 81
impostazioni di 

accensione/spegnimento 
automatico, 54

spegnimento automatico, 35
tipi usati, 17

licenza
codici a barre non Agilent, 21
scansione ad elevata risoluzione, 20

Log di report, 41

M
messaggi di errore, 88

dove e quando appaiono, 88
non presenti nella tabella, 94
tabella in ordine alfabetico, 89

mettere in funzione lo scanner, 22

N
numero di serie, scanner, 74, 75

O
operazioni di manutenzione, 68 to 70

P
posizionamento dei vetrini, 17
prefisso di denominazione 1 e 2, 56
preparazione del sito, 14
prestazioni segnale-disturbo, 17

principi di funzionamento, 17
eccitazione laser, 17
posizionamento dei vetrini, 17
rilevamento della fluorescenza, 18
scansione, 17
sottrazione dark offset, 18

procedura di inizializzazione, 23
Profile Editor, 54, 55
profili, 54

creazione, 56
modifica, 55
modifica delle impostazioni, 45

profilo
definizione, 37, 44

pulizia del filtro dell’aria, 70

R
rapporto XDR, 51
regione di scansione

area, 49
creazione per vetrini non Agilent, 59
definizione, 59
modifica per vetrini non Agilent, 61

regioni di scansione, 54
creazione, 60
modifica, 61

report di scansione, 41
requisiti del computer, 12
riciclo e smaltimento, 102
rilevamento della fluorescenza, 18
rimozione dei vetrini, 33
rimozione delle coperture dello 

scanner, 72
risoluzione dei problemi

acquisizione di dati diagnostici, 83
assistenza tecnica, 74
braccio di caricamento automatico 

esteso nel caricatore, 82
con indicatori luminosi di stato, 78
FAQ, 76
hardware, 78 to 81
messaggi di errore, 88 to 94
sostituzione dei fusibili, 80 to 81
utilizzo del CD di ripristino, 87

risoluzione della scansione, 49

S
Scan Region Editor, 54, 59

avvio, 59
creazione di nuove regioni di 

scansione, 59, 60
modifica di regioni di scansione 

esistenti, 61
scanner

accensione, 22
avvertenza sulla rimozione delle 

coperture, 72
inizializzazione, 22
interferenza elettromagnetica, 102
interruzione durante la scansione, 41
operazioni di manutenzione, 68 to 70
specifiche, 96
spostamento, 72

scansione, 17
scansione dei vetrini, 32, 36

avvio del ciclo del caricatore, 39
impostazione della posizione degli 

slot, 36
selezione di un profilo, 37

scansione dello slot, 39
scansione, definizione, 32
scansioni

tabella dello spazio di archiviazione e 
tempo di scansione, 50

selezione di un profilo, 37
sicurezza

linee guida, 16
norme, 103
simboli utilizzati per lo scanner, 15

simboli di sicurezza, 15
slot vuoti, individuazione di, 49
software

avvio, 22
finestra principale, 23
icona, 22
manutenzione, 68
non risponde, 76
requisiti di sistema, 12

sottrazione dark offset
descrizione, 18

specifiche, 15
codici a barre, 99
scanner per microarray, 96
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specifiche dei vetrini
dimensioni di scansione, 98
vetro dei vetrini, 98

spostamento dello scanner, 
precauzioni, 72

stato, nella finestra di dialogo Scan 
Progress, 39

T
tempo di scansione, 40, 97
tensione di ingresso

impostazioni, 105
verifica, 105

trasferimento dei file, 42

U
umidità, 71
unità di rete, 38, 52, 76

V
vetrini

descrizione per la scansione, 52
incastrati, 77
inserimento nei portavetrini, 24
inserimento nel caricatore circolare, 24
rimozione, 33
scansione, 32
specifiche, 98

vetrini Agilent
inserimento automatico codici a 

barre, 48
inserimento manuale codici a barre, 48

vetrini non Agilent
creazione di una regione di 

scansione, 59
vista dall’alto dello scanner, 13
vista frontale dello scanner, 13
vista posteriore dello scanner, 14
visualizzazione report, 41
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